
 
 
 

TRAIN DISPATCHER 3.5 
User Manual 

 
10 November, 2003 

 
 
 
 

 
 
 

 
 
 

Copyright 2000 Signal Computer Consultants 
All rights reserved 



Train Dispatcher 3.5 

 Page ii  
14 November, 2003 

 
 
 
 
 
 
 
 
 
 

Signal Computer Consultants 
P.O. Box 18445 

Pittsburgh, PA  15236 
 

Tel. 888 872-4612 (toll free US and Canada only) 
Tel. 412 655-1884 
Fax. 412 655-1893 

E-mail signal@signalcc.com 
Web Page www.signalcc.com  

 

 
 

Train Dispatcher 3 and Track Builder 3 are dedicated to 
Frank Bryan and Fred Frailey who tested both programs 
over a four month period and provided many suggestions 
on improvements. 
 
It is doubtful that these programs could have been 
successfully completed without their help and support. 



Train Dispatcher 3.5 

 Page i  
14 November, 2003 

Table of Contents 
 

1. INSTALLATION........................................................................................................................................................................................1 
1.1. Loading the Program........................................................................................................................................................................................ 1 
1.2. Starting the Program....................................................................................................................................................................................... 1 
2. WHAT’S NEW..........................................................................................................................................................................................1 
3. GETTING FAMILIAR WITH TRAIN DISPATCHER.......................................................................................................................3 
3.1. Screen Components ......................................................................................................................................................................................... 3 
3.2. Track Diagram Symbols .................................................................................................................................................................................. 4 
3.3. Moving Around the Screen............................................................................................................................................................................ 6 
3.4. Display Views........................................................................................................................................................................................................ 7 
3.4.1. Classic and Graphic Views ............................................................................................................................................................................. 7 
3.4.2. Displaying Block Information ......................................................................................................................................................................... 8 
3.5. Displaying Detailed Track and Train Information ................................................................................................................................. 9 
3.5.1. Track Block Information .................................................................................................................................................................................. 9 
3.5.2. Switch Information.......................................................................................................................................................................................... 13 
3.5.3. Diamond Information..................................................................................................................................................................................... 14 
4. STARTING A SIMULATION..............................................................................................................................................................14 
4.1. Restarting a Simulation................................................................................................................................................................................ 15 
4.2. Territory Libraries........................................................................................................................................................................................... 15 
4.3. Changing the Territory.................................................................................................................................................................................. 16 
4.4. Saving a Simulation......................................................................................................................................................................................... 16 
4.5. Opening a Previously Saved Simulation ................................................................................................................................................. 16 
4.6. Loading Previous Simulation ...................................................................................................................................................................... 16 
4.7. Saving the Startup Switch Positions and Signal Conditions ......................................................................................................... 16 
5. MODES OF OPERATION ...................................................................................................................................................................16 
5.1. Simulation (no playback) Mode.................................................................................................................................................................. 17 
5.2. Simulation (with playback) Mode .............................................................................................................................................................. 17 
5.3. Playback Mode ................................................................................................................................................................................................. 17 
5.4. CTC Control Mode .......................................................................................................................................................................................... 18 
5.5. External I/O Mode .......................................................................................................................................................................................... 18 
6. DISPATCHING OPERATIONS .........................................................................................................................................................18 
6.1. Switch Control................................................................................................................................................................................................... 18 
6.2. Signal Control.................................................................................................................................................................................................... 19 
6.2.1. Signal Commands ........................................................................................................................................................................................... 19 
6.2.2. Signal Fleeting................................................................................................................................................................................................... 20 
6.2.3. Running Time on a Signal ............................................................................................................................................................................ 20 
6.2.4. Entrance-Exit Signal Commands............................................................................................................................................................... 20 
6.2.5. Stack Route Commands .............................................................................................................................................................................. 21 
6.2.6. Automatic Signaling of Diamonds............................................................................................................................................................ 22 
6.3. Train Speeds...................................................................................................................................................................................................... 22 
6.4. Train Commands............................................................................................................................................................................................. 22 
6.4.1. Train XXX Stop Now Command................................................................................................................................................................ 23 
6.4.2. Train XXX Stop in Block Command......................................................................................................................................................... 23 
6.4.3. Train XXX Start Movement Command.................................................................................................................................................. 23 
6.4.4. Train XXX Clear Stop in Block XXX.......................................................................................................................................................... 23 
6.4.5. Train XXX Pass Red Signal Command .................................................................................................................................................. 23 
6.4.6. Train XXX Reverse Train Command....................................................................................................................................................... 23 
6.4.7. Train XXX Change Crew Command........................................................................................................................................................ 24 
6.4.8. Train XXX Merge with Train XXX Command ...................................................................................................................................... 24 
6.4.9. Train XXX Split Command........................................................................................................................................................................... 24 
6.4.10. Use of Helper Trains...................................................................................................................................................................................... 24 
6.5. Trains at Junctions......................................................................................................................................................................................... 25 
6.6. Permission to Enter Territory.................................................................................................................................................................... 26 
6.7. Block Permit Request.................................................................................................................................................................................... 26 
6.8. Crew Calling ....................................................................................................................................................................................................... 27 
7. SIMULATION STATUS INFORMATION.......................................................................................................................................27 
7.1. Train Status Line.............................................................................................................................................................................................. 27 



Train Dispatcher 3.5 

 Page ii  
14 November, 2003 

7.2. Active Train List ................................................................................................................................................................................................28 
7.3. Train Territory Arrival Schedule ................................................................................................................................................................29 
7.4. Train Platform Schedule...............................................................................................................................................................................30 
7.5. Train Graph.........................................................................................................................................................................................................31 
7.6. Performance Data ..........................................................................................................................................................................................31 
7.7. Active Block Permits ......................................................................................................................................................................................32 
7.8. Active Slow Orders..........................................................................................................................................................................................33 
7.9. Alert System.......................................................................................................................................................................................................34 
8. OPTIONS................................................................................................................................................................................................. 36 
8.1. Random Performance...................................................................................................................................................................................36 
8.1.1. Random Train Parameters .........................................................................................................................................................................36 
8.1.2. Random Defect Detector Parameters ..................................................................................................................................................37 
8.1.3. Random Switch and Signal Failure Parameters................................................................................................................................38 
8.2. Alert Options ......................................................................................................................................................................................................39 
8.3. Function Activation..........................................................................................................................................................................................41 
9. TERRITORY DATA............................................................................................................................................................................... 41 
9.1. Territory Data....................................................................................................................................................................................................41 
9.2. Train Type Descriptions ................................................................................................................................................................................43 
9.3. Train Information .............................................................................................................................................................................................44 
9.3.1. Train Data - General Dialog .........................................................................................................................................................................46 
9.3.2. Train Data - Multiple Entries Dialog .........................................................................................................................................................47 
9.3.3. Train Data - Work Schedule Dialog..........................................................................................................................................................48 
9.3.4. Train Data - Passenger Schedule Dialog...............................................................................................................................................49 
9.4. Simulation Start Times..................................................................................................................................................................................50 
9.5. Entrance/Exit Locations...............................................................................................................................................................................52 
9.6. Block Permits ....................................................................................................................................................................................................53 
9.7. Slow Orders........................................................................................................................................................................................................54 
9.8. Wayside Detectors .........................................................................................................................................................................................56 
9.9. OS Names ...........................................................................................................................................................................................................56 
10. FINDING A TRAIN, TRACK, BLOCK, SWITCH, DIAMOND OR SIGNAL ......................................................................... 57 
11. CTC CONTROL MODE ....................................................................................................................................................................... 58 
11.1. Handler Communication...............................................................................................................................................................................58 
11.2. CTC Control Mode Functions......................................................................................................................................................................58 
11.3. CTC Control Log File .......................................................................................................................................................................................59 
11.4. Train Tracking....................................................................................................................................................................................................59 
11.5. Train Parameters and Commands..........................................................................................................................................................60 
11.6. Speed Control....................................................................................................................................................................................................61 
11.7. Train ID Reporting ...........................................................................................................................................................................................61 
11.8. Block Permits (T & T) .....................................................................................................................................................................................61 
11.9. Test Handler ......................................................................................................................................................................................................62 
11.10. Command Records.........................................................................................................................................................................................63 
11.11. Status Indication Records............................................................................................................................................................................68 
12. EXTERNAL I/O INTERFACE............................................................................................................................................................ 70 
12.1. External I/O Log File .......................................................................................................................................................................................71 
12.2. Command Records.........................................................................................................................................................................................71 
12.3. Status Indication Records............................................................................................................................................................................75 
13. TECHNICAL SUPPORT...................................................................................................................................................................... 79 
14. WARRANTY.......................................................................................................................................................................................... 79 
 



Train Dispatcher 3.5 

 Page iii  
14 November, 2003 

List of Figures 
 

Figure 1 - Train Dispatcher Screen ..................................................................................................................................... 3 
Figure 2 - Train Dispatcher Screen Bottom ....................................................................................................................... 4 
Figure 3 - Track Symbols...................................................................................................................................................... 5 
Figure 4 - Classic View ......................................................................................................................................................... 8 
Figure 5 - Block Speeds........................................................................................................................................................ 9 
Figure 6 - Block Lengths ....................................................................................................................................................... 9 
Figure 7 - Track Block Status Line ...................................................................................................................................... 9 
Figure 8 - Block Properties - General ............................................................................................................................... 10 
Figure 9 - Block Properties - Speed .................................................................................................................................. 12 
Figure 10 - Switch Status Line ........................................................................................................................................... 13 
Figure 11 - Switch Information ........................................................................................................................................... 13 
Figure 12 - Diamond Status Line....................................................................................................................................... 14 
Figure 13 - Start Time and Day Selection ........................................................................................................................ 15 
Figure 14 - Simulation Playback Time Dialog.................................................................................................................. 17 
Figure 15 - Switch Normal and Reverse .......................................................................................................................... 18 
Figure 16 - Signal Fleeting ................................................................................................................................................. 20 
Figure 17 - Entrance-Exit Signal Commands .................................................................................................................. 21 
Figure 18 - Crew Call .......................................................................................................................................................... 24 
Figure 19 - Diamond Train Frequency Example ............................................................................................................. 25 
Figure 20 - Train Entry Request Dialog ............................................................................................................................ 26 
Figure 21 - Block Permit Request Dialog ......................................................................................................................... 26 
Figure 22 - Train Status Line.............................................................................................................................................. 27 
Figure 23 - Active Train List Window ................................................................................................................................ 28 
Figure 24 - Train OS Window............................................................................................................................................. 29 
Figure 25 - Train Territory Arrival Window ....................................................................................................................... 30 
Figure 26 - Train Platform Schedule Window .................................................................................................................. 30 
Figure 27 - Train Graph ...................................................................................................................................................... 31 
Figure 28 - Performance Window...................................................................................................................................... 32 
Figure 29 - Active Block Permit List Window ................................................................................................................... 32 
Figure 30 - Active Slow Order List Window ..................................................................................................................... 34 
Figure 31 - Alert Messages ................................................................................................................................................ 35 
Figure 32 - Alert Message Window ................................................................................................................................... 36 
Figure 33 - Random Train Parameters Dialog................................................................................................................. 36 
Figure 34 - Random Defect Detector Parameters Dialog .............................................................................................. 38 
Figure 35 - Random Switch and Signal Failure Parameters Dialog ............................................................................. 39 
Figure 36 - Alert Parameters Dialog.................................................................................................................................. 40 
Figure 37 - Function Activation Dialog.............................................................................................................................. 41 
Figure 38 -Territory Data Dialog ........................................................................................................................................ 42 
Figure 39 - Territory Comments File ................................................................................................................................. 42 
Figure 40 - Train Type Data Window ................................................................................................................................ 43 
Figure 41 - Train Type Dialog ............................................................................................................................................ 43 
Figure 42 - Train Data Window .......................................................................................................................................... 45 
Figure 43 - Train Data - General Dialog ........................................................................................................................... 46 
Figure 44 - Train Data - Multiple Entries Dialog .............................................................................................................. 47 
Figure 45 - Train Data - Work Schedule Dialog .............................................................................................................. 48 
Figure 46 - Train Data - Passenger Schedule Dialog..................................................................................................... 49 
Figure 47 - Start Times Window ........................................................................................................................................ 50 
Figure 48 - Start Time Data Dialog.................................................................................................................................... 51 
Figure 49 - Entrance/Exit Location Window..................................................................................................................... 52 
Figure 50 - Block Permits Window .................................................................................................................................... 53 
Figure 51 - Block Permit Dialog ......................................................................................................................................... 54 



Train Dispatcher 3.5 

 Page iv  
14 November, 2003 

Figure 52 - Slow Orders Window .......................................................................................................................................54 
Figure 53 - Slow Order Data Dialog ..................................................................................................................................55 
Figure 54 - Wayside Detector Data Window ....................................................................................................................56 
Figure 55 - OS Data Window..............................................................................................................................................57 
Figure 56 - Find a Train Dialog...........................................................................................................................................57 
Figure 57 - Train Information ..............................................................................................................................................60 
Figure 58 - CTC Active Train List.......................................................................................................................................60 
Figure 59 - CTC Active Block Permit (T&T) List ..............................................................................................................61 
Figure 60 - CTC Block Permit Dialog ................................................................................................................................62 

 
 



Train Dispatcher 3.5 

 Page 1  
14 November, 2003 

 

1. INSTALLATION 

1.1. Loading the Program 
Train Dispatcher 3 is a 32-bit Windows program that will run on systems running Windows 95, 98, 2000, NT 
3.51 or NT 4.0 or later.  It will not run under Windows 3.1. 

Train Dispatcher comes on a CD-ROM.  To install the program, insert the CD-ROM into the CD-ROM drive and 
click the Start and then the Run buttons.  In the Open box, type d:autorun.exe if your CD-ROM is the D drive on 
your computer.  If it is not the D drive, type the appropriate drive letter followed by a colon and then autorun.exe 
(ex. e:autorun.exe, f:autorun.exe, etc.).  Follow the instructions in the installation program to complete the 
installation.  The Setup program will ask you for a serial number.  The serial number for Train Dispatcher 3 is the 
same serial number you received for Train Dispatcher and/or Train Dispatcher 2. 

When Train Dispatcher 3 is installed, the Setup program will load the program into the Train2 folder (default) 
and create a desktop icon. 

1.2. Starting the Program 
There are four ways to start the program.  To start the program: 

♦ Click the Start button, point to Program, then to the Train2 folder, and click on the Train Dispatcher 3 
program. 

♦ Double click on the Train Dispatcher 3 icon on the desktop. 

♦ Open the Windows Explorer, find the Train Dispatcher 3.exe file in the Train2 folder and double click on 
the file. 

♦ Open the Window Explorer, find a track file (track files have a .trk file name extension) in the Train2 
folder, and double click on the file.  This will cause the Train Dispatcher 3 program to start and load the 
track file on which you clicked. 

After starting the program, the Track Display appears (see Figure 1). 
 

2. WHAT’S NEW 
Train Dispatcher 3 has been designed to meet the requirements of a major Class I railroad and also include 
many of the suggestions from our Train Dispatcher 2 customers.  Territories developed using Track Builder 2 
can be loaded into Train Dispatcher 3; however, some of the new features require data they can only be 
generated by the Track Builder 3 program. 

The following is a brief list of some of the new features of Train Dispatcher 3: 

♦ Simulations can run for multiple days up to 90. (TB3 territory files only). 

♦ Routes can be cleared by designating an entrance and an exit signal (Union routing). 

♦ Routes can be stacked.  Users can specify up to 5 stacked routes per signal that will automatically be 
cleared for the next train, after the previous route has been completed or cancelled 

♦ Trains can be given permission to proceed past a red signal. 

♦ Trains can be merged or split into two trains. 

♦ The user can request a train to stop anywhere on the territory. 

♦ Trains can be reversed at any location in a block and in blocks that are used to enter or exit the territory. 
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♦ Helpers may be required in order for some train types to move through some blocks. (TB3 territory files 
only). 

♦ Trains scheduled to arrive on the territory can be easily displayed by clicking on an entrance/exit 
location. 

♦ Trains scheduled to stop at a platform can be easily displayed by clicking on a block that contains the 
platform. 

♦ The user may be required to give permission before trains can enter the territory at designated 
locations. (TB3 territory files only). 

♦ Crews can expire because their time on duty has exceeded the 12-hour limit. 

♦ The user can call crews and specify where the crew exchange will occur for a given train. 

♦ Block permits and slow orders can be scheduled for different days of the week. 

♦ The user must grant permission before a block permit can go into effect. 

♦ Some entrance/exit locations can be designated as yard entry locations, and the user can specify how 
often trains can enter the yard (leave the territory).   (TB3 territory files only).  

♦ Slow orders can be made permanent. 

♦ Diamonds (at grade crossings) are supported. (TB3 territory files only). 

♦ Diamonds used as part of a junction with a foreign railroad can specify how often a train on the foreign 
railroad with be cleared over the diamond.  (TB3 territory files only). 

♦ Diamonds can be set up for automatic signaling which allows conflicting routes to be cleared over the 
diamond at the same time.  The first train that hits the approach block to the diamond gets the route. 
(TB3 territory files only). 

♦ Trains can be scheduled to perform local work in designated blocks. (TB3 territory files only). 

♦ Signals can fail and require a maintainer to fix. 

♦ When switches fail, the user can specify that a train crew can manually throw the switch. 

♦ Train OSs are recorded and a train graph can be displayed. (TB3 territory files only). 

♦ A simulation can be recorded and later played back. 

♦ Train schedules, block permits, and slow orders can be changed in Train Dispatcher 3. 

♦ Trains can develop problems (such as a broken hose). 

♦ Locomotives can develop problems that degrade the performance of the train. 

 

Train Dispatcher 3 is an extremely realistic simulation of a dispatcher ‘s job.  Because of the many 
enhancements, a novice user can find the simulation overwhelming.  To alleviate this problem Train Dispatcher 
3 allows the user to turn off many of the optional functions. The following is a list of function that can be turned 
off: 

♦ Slow Orders 

♦ Block Permits 

♦ Crew Calling 

♦ Helper Requirements 

♦ Requiring the user to grant permission before allowing a train to enter the territory. 

♦ Limiting how often a train can enter a yard. 
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3. GETTING FAMILIAR WITH TRAIN DISPATCHER  

3.1. Screen Components 
Figure 1 shows the main Train Dispatcher screen. 

 

Status 
Display Line 

Clock 
Time 

Clock 
Status 

Time 
Multiplier

 
Figure 1 - Train Dispatcher Screen 

Under the menu bar there is a tool button bar containing a number of items.  The following describes these 
items in order from left to right: 

♦ Clock time - displays the game’s simulation time in 24-hour military time, the day of the week, and the 
number of days since the start of the simulation. 

♦ Clock status - displays the status of the simulation’s clock.  “Run” indicates time is running, and “Stop” 
means  the clock is stopped. 

♦ “Stop” button - when clicked causes the simulation’s clock to stop. 

♦ “Start” button - when clicked causes the simulation’s clock to start. 

♦ Time multiplier - displays how many times faster than real time the simulation’s clock is running.  If, for 
example, the time multiplier is 30, the clock will run 30 times faster than normal and will, therefore, be 
incremented one minute for every 2 seconds of real time. 

♦ “T up arrow” button - when clicked causes the time multiplier to be increased. 

♦ “T down arrow” button - when clicked causes the time multiplier to be decreased. 

♦ “Turn Sound Off (Turn Sound On)” - when clicked causes the sounds generated for various alerts to 
be turned off (or on if the sound is already off). 

♦ “Prev Alert” button - when clicked causes the previous alert message to be displayed in the status line 
located below the button. 

♦ “Next Alert” button - when clicked causes the next alert message to be displayed in the status line 
located below the button. 

♦ “Go to Alert” button - when clicked causes the screen to automatically scroll to, and the mouse pointer 
to be placed on, the train or block that generated the alert,  

♦ “Zoom In/Out” button - when clicked zooms the track diagram either in or out depending on its current 
zoom status. 
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♦ “Back” button - when clicked scrolls and zooms the screen back to its previous location and zoom 
status. 

♦ “Fwd” button - when clicked returns the screen to the location and zoom status that was displayed 
before the “Back” button was clicked. 

Under the tool button bar there is a Status Display Line that displays, depending on the location of the mouse 
pointer, information about trains, blocks, switches, diamonds, signals, entrance/exit locations, or alert 
messages.  If the mouse pointer is on a block that is occupied by a train, train status will be displayed.  If the 
mouse pointer is on a switch, diamond, signal, or unoccupied block, information about that device will be 
displayed.  If the mouse pointer is not on a block, switch, diamond or signal, an alert message will be displayed. 

Track File 
Name 

Performance 
Status Line 

 

Figure 2 - Train Dispatcher Screen Bottom 
At the bottom of the screen there is a message line (see Figure 2).  This message line contains the file name of 
the track territory currently being displayed and the Performance Status Line. 

The Performance Status Line contains the following items in left to right order: 

♦ The number of trains currently on the territory. 

♦ The total number of miles trains have traveled since the beginning of the simulation. 

♦ The total number of miles all trains have traveled divided by the number of hours the simulation has 
been running. 

♦ The total amount of time trains have been stopped waiting for signals to clear and the total amount of 
time trains have been stopped due to crew expirations. 

♦ The total amount of time lost since the beginning of the simulation because trains were not moving at 
their maximum speed. 

♦ The total amount of time since the beginning of the simulation that trains were late in departing station 
platforms. 

♦ The number of times since the beginning of the simulation that trains were late departing station 
platforms. 

3.2. Track Diagram Symbols 
The track diagram has a number of symbols to represent tracks, switches, diamonds, signals, trains, etc.  Many 
of these symbols are shown in Figure 3. 
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Figure 3 - Track Symbols 
The following lists the different symbols and the meaning of the colors used to indicate their status: 

♦ Straight lines drawn on the track diagram represent railroad track.  The vertical or horizontal bars drawn 
perpendicular to the track line indicate the beginning or termination of a track block.  The track is broken 
down into a number of blocks.  Block lengths may vary, and several trains can occupy a block at a given 
time. 

 The following describes the meaning of the different track block colors: 

o Red - indicates a train occupies the track block.  A train identifier will appear above the block that 
contains the train.  If the screen is in “Graphic” display mode an icon representing a locomotive is 
displayed on the track.  If the train is moving in reverse an icon representing a caboose is displayed. 

If more than one train occupy a block, the train identifiers of the other trains in the block will be 
displayed below the track.  The lead train will be above the track and the following trains will be 
displayed below the track in the order in which they are moving through the block. 

If any of the train identifiers are displayed in red those trains are at stop.  If in blue, those trains are 
moving. 

A train may occupy more than one block at a time since a train can be longer than a block.  If the 
program is in “Graphic” display mode a locomotive will partially overlay the block into which a train is 
moving and a caboose will partially overlay the block the train is leaving. 

Arrows will be displayed to indicate the direction in which trains are moving.  Locomotive and 
caboose icons may, in some cases, be displayed on top of these arrows. 

o Green - indicates the track block is part of a cleared route.  Arrows indicate the direction of the 
route. 

o Yellow – indicates the track is part of a route that is stacked (scheduled to be automatically 
cleared).   

o Light Blue - indicates a block permit will become active in the next 30 minutes.  The time at which 
the block permit will become active is displayed above the track block. 

o Dark Blue - indicates a block permit is active.  The time the block permit will expire is displayed 
above the track block. 
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• If track blocks are blinking, they are part of a route that is running time (see Paragraph 6.2.3) 
and, therefore, cannot be cleared until a specified time period has elapsed. 

♦ If the screen is in the “Graphic” display mode, a yellow box signifies a switch location.  Switches have 
two positions, which are called normal and reverse.  The normal position causes the train to proceed 
through the switch along the straight track as it would if there were no switch present (see Paragraph 
6.1).  The reverse position causes the train to change course and move off at an angle to the straight 
track.  

 The yellow box around the switch will turn light blue if the switch fails. 

A blinking switch indicates the user tried to clear a route that could not be cleared.  Switches will also 
blink if they are part of a route that is running time (see Paragraph 6.2.3). 

♦ A diamond (at grade crossing) is represented by two lines that cross each other.  Diamonds will be 
displayed in the same color combinations as track blocks.  

♦ Any one of four different symbols can represent a signal  These symbols consist of a mast and a signal 
ball.  If the signal ball is to the right of the mast, the signal controls train movement to the right and, 
conversely, signals with the ball to the left of the mast control movements to the left.  Signals that have 
long signal masts can be fleeted (see Paragraph 6.2.2), and signals with short masts cannot be fleeted. 

A red signal ball indicates the signal is at stop, a green ball indicates the signal is cleared for traffic to 
proceed, and a blue ball indicates the signal has failed.  If a gray signal ball also appears, the signal is 
fleeted. 

Signals that are blinking are running time. 

A signal that is the entrance signal to one or more a stacked routes will have the number of stack routes 
displayed near the base of the signal (see Paragraph 6.2.5). 

♦ A station platform is represented by a gray rectangle located near the track block that contains the 
platform.  Usually a passenger station name appears near the platform symbol. 

♦ Entrance/exit location names are assigned to any track block that is not connected to another block or 
switch.  These names are two characters long and are displayed in blue (white in the “Classic” view) at 
the end of the block that does not have a connecting switch or block.  Entrance/exit locations are places 
where trains enter and exit the territory. 

3.3. Moving Around the Screen 
Most territories will not completely fit on the screen when the territory is zoomed-in (old Closeup View).  
However, if you are using a screen with a resolution of 800 by 600 pixels, most territories designed should 
entirely fit on the screen when the territory is zoomed-out (old Overview).  The Northeast Corridor territory from 
Washington, DC to Philadelphia, because of its size, will not entirely fit on a screen with a resolution of 800 by 
600 but will fit on a screen with a resolution of 1024 by 768. 

There are a number of ways to move around the territory.  The following lists these: 

♦ Scroll using the horizontal and vertical scroll bars located at the bottom and right side of the screen. 

♦ Press the “Home”, “End” “Pg Up”, “Pg Dn” or arrow keys to scroll the screen. 

♦ Press a key that represents a station call up character.  Each station name on the screen has a station 
call up character assigned.  These call up characters are displayed above the station names.  In Figure 
3 the “Analomink” station is assigned a call up character of “G”.  If, for example, you press the “G” key 
the screen will scroll to position the “Analomink” station as close to the center of the screen as possible. 

♦ Position the mouse pointer close to the edge of the screen.  If the pointer is not located on a block, 
switch or signal, it will turn to a solid arrow pointing in the direction the screen will scroll if you click the 
left mouse button. 
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♦ Position the mouse pointer on any grid square that does not contain a train, switch, signal, diamond or 
track block.  If you click the right mouse button, the screen will zoom in or out depending on its current 
zoom mode, and the mouse pointer will be positioned at its location on the screen prior to the operation. 

♦ Position the mouse pointer on a track at the far left or far right of the screen.  If you click the left mouse 
button the screen will scroll to, and the mouse pointer will be placed on, the track that is linked to the 
first track.   

3.4. Display Views 

3.4.1. Classic and Graphic Views 
There are two display views.  We have named these views “Graphic” and “Classic”.  The “Graphic” view has a 
white background and displays locomotive and caboose icons.  There are yellow boxes around each of the 
switches, and graphics representing objects such as bridges, rivers, buildings, etc. are displayed. 

Most real Centralized Traffic Control systems do not use icons to display trains.  They mainly use train identifiers 
and different colored track lines displayed on a black or dark background.  Train Dispatcher 3 can simulate this 
type of classic or traditional display (see Figure 4). To display the territory in the “Classic” view click the “Classic 
View” item under the “View” menu. 
 

 
Figure 4 - Classic View 
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3.4.2. Displaying Block Information 
Blocks lengths, speeds, signal directions and names can be displayed on the track diagram when in zoom-in 
mode.  Only one of these items can be displayed at a given time.  For blocks that are occupied by a train, have 
a cleared route, or have an active block permit, no block information will be displayed.  Figure 5 shows the block 
speeds displayed on the track diagram.  The speeds above the track line are for trains moving to the left and 
below the track for train moving to the right.  The speeds displayed apply when two or more signals are cleared 
ahead of the block.  The first number is the highest train type speed and the second the lowest train type speed 
for that block.  

 
Figure 5 - Block Speeds 

Figure 6 shows the block lengths in feet and miles displayed on the track diagram.  Lengths are displayed in feet 
or meters above the track and in miles or kilometers below the track. 

 
Figure 6 - Block Lengths 

The track diagram can be printed out at any time by selecting the “Print Track Layout Diagram” menu item under 
the “File” menu.  The block information displayed on the screen when the track diagram is printed will also 
appear on the printed copy, which can be used for reference.  Block speeds, lengths, signal directions or names 
will not appear on either the track diagram or a printout of the track diagram when the screen is zoomed out. 

3.5. Displaying Detailed Track and Train Information 

3.5.1. Track Block Information 
When the user places the mouse pointer on a grid square that contains a track symbol and is not occupied by a 
train, the status display line located under the tool button bar at the top of the screen will display some 
information about the track block (see Figure 7). 
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Figure 7 - Track Block Status Line 
The information fields in the status line from left to right are the following: 

♦ The track block number 

♦ The track name or an indication that the selected block is a connecting line.  Connecting lines are not 
real blocks and, therefore have no length.  Connecting lines link switches and diamonds to real blocks. 

♦ The train speeds in the block.  The first two speeds are for trains moving to the left, and the second two 
for trains moving to the right.  These speeds apply when two or more signals are cleared ahead of the 
block.  The first number is the highest train type speed, and the second is the lowest train type speed for 
that block. 

If a slow order is active, the highest and lowest slow order speeds will be displayed instead of the 
normal train speeds for the block. 

� The length of the block in feet (meters). 

� The direction(s) in which the block is signaled (Left, Right or Both directions). 

♦ The name of the passenger platform located in the block.  If no platform is located in the block, nothing 
will be displayed. 

♦ The name of the OS point assigned to the block.  If no OS point is assigned, nothing will be displayed. 

♦ The name of the area (work area) associated with the block.  If no area is associated, nothing will be 
displayed. 

♦ The types of the wayside detectors located in the block.  Up to three detectors can be located in a block.  
If there are no detectors in the block, nothing with be displayed. 

To display more information about the track block, place the mouse pointer on the block and click the right 
mouse button.  If a train occupies the block, a pop-up menu will appear.  Select the “Block XXX Properties” 
menu item and Figure 8 will appear.  If a train does not occupy the block, Figure 8 will appear immediately. 
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Figure 8 - Block Properties - General 
Data in this dialog was created via Track Builder and cannot be modified by the Train Dispatcher 3 user.  The 
following describes each of the fields in this dialog: 

♦ Number - the unique number assigned to the block. 

Track name - the name of the track block   

♦ Connector - a check box to indicate whether or not the block is a connecting line that does not have 
length or hold trains 

♦ Left device - the block, switch or diamond to the left 

♦ Entrance/Exit name (Left) - the entrance/exit name to the left of the block. 

♦ Right device - the block, switch, or diamond to the right   

♦ Entrance/Exit name (Right) - the entrance/exit name to the right of the block 

♦ Signal Direction - indicates if the block is signaled in the left and/or right direction.  Usually blocks are 
signaled in both directions.  If not, trains can only move in the direction in which the block is signaled. 

♦ Block Length - the length of the block in feet, miles, meters or kilometers 

♦ Left exit control signal - the signal number of the controlled signal that allows a train moving to the left 
to exit the block.  If no signal number is displayed the program assumes the exit signal is automatic. 

♦ Right exit control signal - the signal number of the controlled signal that allows a train moving to the 
right to exit the block.  If no signal number is displayed the program assumes the exit signal is 
automatic. 

♦ Normal crew change point - a check box to indicate if crews are normally changed in the block 

♦ Delay in block because of crew change - the amount of time (in minutes) for the crews to change 
once the new crew has arrived 
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♦ Time to send crew to block - the amount of time (in minutes) it will take the new crew to get to the 
block after being is called  

♦ Platform name - contains the passenger platform name assigned to the block.  Passenger trains that 
are scheduled to stop at a particular platform will stop in blocks that are assigned to the platform name.  
Several blocks can be assigned to the same platform name. 

If a platform is not assigned to the block, “none” will be displayed in this field. 

♦ Area name - contains the name of the area to which the block is assigned.  Blocks can be grouped in 
areas.  Areas are used to define locations where trains will perform local work or where trains will either 
become new trains or be split into multiple trains. 

If the block is not assigned to an area, “none” will be displayed in this field. 

♦ Wayside detectors - up to three wayside detectors can be located in a block.  Wayside detectors check 
the train for problems such as hot boxes and dragging equipment 

If a wayside detector is not located in the block, “none” will be displayed in these fields. 

♦ OS point - contains the OS point assigned to the block.  OS points are used to create a train graph.  OS 
points can be assigned to multiple blocks or switches. 

If an OS point is not assigned to the block, “none” will be displayed in this field. 

♦ Remote monitor name - An advanced version of Train Dispatcher 3 is capable of monitoring and 
controlling external devices such as real railroad ground equipment or a model railroad display.  The 
remote monitor name is used to associate external devices to the devices in the Train Dispatcher 3 
display. 

Speeds must be assigned to the block for each different type of train for each of the three signal aspects.  To 
display the Block Speed dialog click the Block Speeds tab at the top of the Block Properties dialog (see Figure 
8), and Figure 9 will appear. 

 

Figure 9 - Block Properties - Speed 



Train Dispatcher 3.5 

 Page 12  
14 November, 2003 

 

♦ BLOCK TRAIN SPEEDS - specifies the speeds of trains based on train type and the number of blocks 
than are cleared ahead.  The system is designed to handle up to four speed aspects.  If the next block 
is not clear, the train will stop when it reaches the end of the current block.  If the block beyond the next 
is not cleared, the train must travel at a lower speed than its maximum in anticipation of stopping at the 
end of the next block. 

Other fields pertaining to train speeds are: 

o TYPE - lists the train type descriptions.   

o NONE (Left/Right Cleared Ahead Blocks) - contains the train speed in the current block if the 
next block is not cleared for the train (train will stop at the end of the current block). 

o ONE (Left/Right Cleared Ahead Blocks) - contains the train speed in the current block if one 
block beyond the current block is cleared for the train. 

o TWO (Left/Right Cleared Ahead Blocks) - contains the train speed in the current block if two 
blocks beyond the current block are cleared for the train. 

o HELPER - if checked indicates that the train type requires a helper for it to travel through the 
block.  The user will have to merge a helper with the train before the train will pass into any 
block for which a helper is required, even if the signal allowing the train to enter the block has 
been cleared. 

o STARTUP - is the time in seconds before the train will start moving into the block if the train is 
at stop waiting for the signal to be cleared. 

3.5.2. Switch Information 
When the user places the mouse pointer on a grid square that contains a switch, the status display line at the 
top of the screen will display some information about the switch (see Figure 10). 

 

Figure 10 - Switch Status Line 
The information fields in the status line from left to right are the following: 

♦ The switch number 

♦ The switch name 

♦ The train speeds when a train goes over a switch that is in the reverse position.  The highest and lowest 
train speeds of all types of trains are shown. 

� Switch failure information including the time a maintainer will arrive to fix a switch. 

To display more information about the switch, place the mouse pointer on the switch and click the right mouse 
button, and the dialog in Figure 11 will appear. 
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Figure 11 - Switch Information 
Data in this dialog cannot be modified by the Train Dispatcher 3 user.  The following describes each of the fields 
in this dialog: 

♦ Switch number - the unique switch number assigned to this switch. 

♦ Switch name - the name of the switch. 

♦ Control/monitor name – An advanced version of Train Dispatcher 3  is capable of monitoring and 
controlling external devices such as real railroad ground equipment or a model railroad display.  The 
remote monitor name is used to associate external devices to the devices in the Train Dispatcher 3 
display. 

♦ OS point - contains the OS point assigned to the switch.  OS points are used by Train Dispatcher 3 to 
create a train graph.  OS points can be assigned to multiple blocks or switches. 

If an OS point is not assigned to the switch, “none” will be displayed in this field. 

♦ Reverse Left Block - the block, switch or diamond to the left of the switch when the switch is in the 
reverse position.  The switch can either have a value in the “Reverse Left Block” or “Reverse Right 
Block” field, but not both.  If the switch does not have a reverse left position, this field will not appear. 

♦ Reverse Right Block - the block, switch or diamond to the right of the switch when the switch is in the 
reverse position.  The switch can either have a value in the “Reverse Left Block” or “Reverse Right 
Block” field, but not both. If the switch does not have a reverse right position, this field will not appear. 

♦ Normal Left Block - the block, switch or diamond to the left of the switch when the switch is in the 
normal position. 

♦ Normal Right Block - the block, switch or diamond to the right of the switch when the switch is in the 
normal position. 

♦ SWITCH REVERSE TRAIN SPEEDS - the speeds to which trains will be limited when moving over a 
switch that is in the reverse position.  Each type of train will travel at the indicated speed for the length 
of time it takes the entire train to move over the switch. 
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If there is no speed in this field for a type of train, the train’s speed over a switch in the reverse position 
will not vary from its normal speed in the block. 

3.5.3. Diamond Information 
When the user places the mouse pointer on a grid square that contains a diamond, the status display line at the 
top of the screen will display some information about the diamond (see Figure 12). 

 

Figure 12 - Diamond Status Line 
The information fields in the status line from left to right are the following: 

♦ The diamond number 

♦ The diamond name 

♦ If the diamond is automatically signaled (see Paragraph 6.2.6) 

♦ The number of trains per day that automatically move left to right and right to left (top to bottom and 
bottom to top) across the diamond (see Paragraph 6.5) 

4. STARTING A SIMULATION 
When Train Dispatcher 3 is executed the last territory used will automatically be loaded.  To load another 
territory select the “Change Territory Track File” menu item under the “File” menu. 

To start the simulation click the “Start” button in the tool bar near the top of the screen.  The first time this button 
is clicked after the program is executed or a new territory is loaded the Start Time and Day Selection dialog will 
appear (see Figure 13). 

 

Figure 13 - Start Time and Day Selection 
Most territories will have multiple start time selections.  Select the start time and day to pre-load the trains that 
are already on the territory at that start time.  To see the list of trains already on the territory for each start time 
select the “Start Time” menu item under the “Data” menu.  
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To start the simulation clock, click the “Start” button again.  The clock will start and trains will begin to move. 

If, after you click the “Start” button, a dialog appears asking for a password, you are trying to simulate a track 
territory from the “For Sale” library which you have not previously used.  See Paragraph 4.2 for more 
information. 

4.1. Restarting a Simulation 
To restart a simulation, click the “File” menu in the menu bar at the top of the screen to display a pop-up menu 
and then click the “Restart Simulation” menu item. 

4.2. Territory Libraries 
Signal Computer Consultants maintains two distinct libraries of territory track files, which we have named the 
“Customer Contributed” and “For Sale” libraries.  As of December 2000 there were over 300 track files available.  
Most of the files were created by our Track Builder customers.  All track files developed with Track Builder 2 and 
Track Builder 3 can be simulated in Train Dispatcher 3.  

The track files (over 150) in the Customer Contributed Library are completely free and can be simulated in Train 
Dispatcher 3.   The track files (over 150) in the For Sale Library can be viewed via Train Dispatcher 3 prior to 
purchase but are password protected for operational purposes.  When a territory from the For Sale Library is 
purchased from Signal Computer Consultants a password is assigned that “unlocks” that territory for use.  The 
first time the user clicks the “Start” button with a “For Sale” territory loaded that has not been previously used, 
the system will ask for the password for that territory.  Once a valid password is entered for the particular 
territory the program will not ask for it again. 

Track files in both the “Customer Contributed” and “For Sale” libraries can be downloaded from our web page at 
www.signalcc.com (select the “Territory Libraries” menu item under the “Web Menu” to go the territory library 
web page) and are included on the Train Dispatcher 3 CD-Rom.  To load these territories from the CD, insert 
the CD into the drive, and a program should automatically load.  If this program does not automatically load, 
click the “Start” button, select the “Run” menu item and then type “D:autorun.exe” where “D” is the drive 
identifier for your CD.   If “D” is not your CD drive, substitute the appropriate letter that identifies your CD drive.  
Finally click the “Ok” button to start the installation program.  

When the installation program starts, it will display buttons for loading the track territory libraries.  Click on the 
button for either the For Sale or Customer Contributed Library, which will open a WinZip Self Extracting 
program.  If you click the “Unzip” button all the tracks in the library chosen will be loaded into the designated 
folder.  If you have WinZip installed on your computer, you can click the “Run WinZip” button to load just the 
territories you want.  If you do not have WinZip on your computer you can download a free evaluation copy from 
their web page at www.winzip.com. 

4.3. Changing the Territory 
There are over 300 territories that can be simulated with Train Dispatcher 3.  To change the territory to be 
simulated, click the “Change Territory Track File” menu item under the “File” menu.  The program will display a 
list of territory files that can be opened.  Each of these files has a file extension of “.trk”.  Select the file to be 
simulated and click the “OK” button.   

4.4. Saving a Simulation 
Train Dispatcher 3 allows you to save the current simulation and restart it at a later time at the point where you 
left off.  To save the current simulation, click the “Save Simulation As” menu item under the “File” menu.  The 
program will ask the user to assign a file name.  The file name must have an extension of “.ssm” to indicate it is 
a saved simulation. 
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4.5. Opening a Previously Saved Simulation 
To run a previously saved simulation click the “Open Previously Saved Simulation” menu item under the “File” 
menu.  A selection box will appear. Select the file to be simulated and click the “OK” button.   After you have 
entered the appropriate day of the week, the simulation will resume where you left off and display the track 
diagram. 

4.6. Loading Previous Simulation 
A list of the 10 most recently used track (.trk) or previous simulation (.ssm) files will appear as menu items under 
the “File” menu.  Simply click on one of these menu items to load the appropriate track or previous simulation 
file. 

4.7. Saving the Startup Switch Positions and Signal Conditions 
After you have simulated a given territory several times you will notice that the initial switch positions and signal 
conditions you set will not vary from time to time.  You will most likely always begin the simulation in the same 
way. It is convenient, therefore, to save these initial switch positions and signal conditions.  To save these 
parameters, before clicking the “Start” button the second time to start the simulation’s clock, set the switch 
positions and signal conditions, and use the “Save Simulation As” menu item under the “File” menu as 
described above.  This action will preserve these initial settings to be returned to on future simulations of the 
territory.  On future uses of the territory choose the “Open Previously Saved Simulation” menu item under the 
“File” menu instead of “Change Territory Track File.”    

5. MODES OF OPERATION 
Train Dispatcher 3 has five modes of operation.  These are: 

♦ Simulation with no playback 

♦ Simulation with playback 

♦ Playback 

♦ CTC Control 

♦ External I/O 

The mode of operation can be selected by clicking the “Mode” menu item in the menu bar.  This will cause a 
pop-up menu to appear with the five modes of operation listed as separate menu items.  Select the appropriate 
menu item to go into that mode of operation.  The following describes these modes of operation: 

5.1. Simulation (no playback) Mode 
This is the normal simulation mode.  Train Dispatcher 3 will simulate the territory, but will not create a playback 
file. 

5.2. Simulation (with playback) Mode 
This mode allows the user to run the simulation and create a playback file.  When this mode is selected, the 
system will first check to see if a simulation is running.  If there is a simulation running the system will ask the 
user if he wants to restart the simulation.  The user must select “Yes” to enter into this mode. 

After the user clicks the “Start” button and selects a start time, the system will then ask the user for the name of 
the playback file.  The file name must have an extension of “.ply” to indicate it is a playback simulation.  Please 
note that the system will generate about 200 to 400 K of data for each hour of the simulation.  For 24 simulated 
hours as much as 12 MB of data will be stored in this file. 

The playback file allows the user to review previous simulations.  Signal Computer Consultants also plans to 
develop a screen saver program from a user generated playback file. 
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5.3. Playback Mode 
In playback mode the system will ask the user for the name of the playback file.  After entering a playback name 
the system will display the Simulation Playback Time dialog in Figure 14. 

 

Figure 14 - Simulation Playback Time Dialog 
The playback of a simulation can be fast forwarded to a particular time in the simulation by entering a time and 
day in the “Jump to start time” and “day of week” fields different from the simulation’s original start time and day.  
Once the system reaches the time and day specified in the “Jump to start time” and “day of week” fields, it will 
continue the playback of the simulation at the speed specified in the “Time Multiplier” field in the tool bar on the 
main screen. 

During playback the user can stop and start the time clock, change the time multiplier, zoom-in or out, scroll 
around the display and display various status windows.  The user cannot throw switches or clear signals during 
playback.  He can, however, at any time in the playback, stop the operation and place the system into the 
simulation without playback mode.  This allows the user to continue on with a new simulation at any point in the 
playback of a previous simulation. 

5.4. CTC Control Mode 
The CTC Control Mode allows a user to  control and monitor a model railroad.  For more information on the 
mode see Paragraph 11.  

5.5. External I/O Mode 
The External I/O Mode allows Train Dispatcher 3 to be driven by an external CTC machine.  Instead of using the 
mouse to clear signals and throw switches, Train Dispatcher 3, in this mode, will get these commands from an 
external machine.  It will also provide signal, switch, and track circuit conditions back to the external machine as 
if these conditions were generated by the wayside equipment. 

For more information on the External I/O Mode see Paragraph 12.  

6. DISPATCHING OPERATIONS 
The primary job of a dispatcher is to move trains over the territory from their origin to their destination as quickly 
as possible.  Because the amount of track is limited, a number of trains traveling in the same and opposite 
directions must often share tracks.  Part of the dispatcher’s job is determining routes that cause the most time 
efficient sharing of the limited trackage.  This can be a very complex task.  The primary tools dispatchers have in 
routing trains are switches and signals. 
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6.1. Switch Control 
Switches allow the dispatcher to change the routes of trains.  Switches have two positions, which are called 
normal and reverse.  The normal position is for a straight move through the switch (see Figure 15).  The reverse 
position is for movement at an angle to the original course. 

Crossover switches
(corresponding) 

Reverse position 

Normal position

 

Figure 15 - Switch Normal and Reverse 
To throw a switch (change its position) place the mouse pointer on the switch, which will cause a box to appear 
around the switch, and click the left mouse button.  If the switch’s position was normal prior to the operation, it 
will change to reverse, and vice versa. 

There are cases where switches will not throw.  If the “Help Messages” menu item is checked (located in a pop-
up menu which will appear when the “Help” menu in the menu bar at the top of the screen is clicked), a 
message will appear to explain why the switch did not throw. 

The following is a list of reasons why a switch might not throw: 

♦ The switch has a train on it (occupied). 

♦ The switch has a cleared route over it. 

♦ The corresponding switch cannot throw.  Two switches can be tied together when they are configured 
as a crossover (see Figure 15).  If you throw one switch, the corresponding switch will automatically 
throw to the same position.  If the corresponding switch cannot throw because it is occupied by a train 
or has a cleared route over it, the switch that was requested to throw also will not throw. 

♦ The switch failed.  Train Dispatcher 3 simulates random failures of switches, which often occur on real 
territories.  You can determine how often random failures will occur by setting parameters in the 
Random Switch and Signal Failure Parameters dialog (see Paragraph 8.1.3). 

6.2. Signal Control 
Signals operate like highway traffic lights.  Trains will not advance beyond a signal unless it is cleared (green).  
All signals on the track diagram have two states called stop (red) and cleared to proceed (green). 

Railroad signaling systems are designed to maintain safe train operations.  Because it can take over a mile to 
stop a 100-car train moving at 60 miles per hour, the locomotive engineers must rely on the signaling system.  
The system is designed to allow only one train to occupy a given track block at a given time.  Each block has 
wayside signals that allow trains to enter the block.  Some blocks have automatic signals, which allow a train to 
enter the block as long as the block is not occupied or does not have a route cleared in the opposite direction.  
Other blocks have controlled signals, which are controlled by the dispatcher and appear on the track diagram.  
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Controlled signals can be located anywhere on the track diagram, but are usually used to control moves over 
switches at interlockings. 

When a signal is cleared, it clears a route to the next controlled signal that is in the same direction.  The route 
may be cleared over a number of blocks and switches.  The switches and blocks in a cleared route are 
displayed in green, with arrows showing the direction of the route. 

6.2.1. Signal Commands 
To change a signal’s state, place the mouse pointer on the signal, which will cause a box to appear around it, 
and click the left mouse button, which will cause the signal to go to the opposite state unless an existing 
condition prevents the change. 

There are many safety reasons why a signal might not clear.  If the “Help Messages” menu item (located in a 
pop-up menu which will appear when the “Help” menu in the menu bar at the top of the screen is clicked) is 
checked, a message will appear explaining why the signal did not clear and blink the switch or block that caused 
the problem. 

The following is a list of reasons why a signal might not clear: 

♦ A route cannot be established to the next signal because a switch is open. 

♦ A block in the route is cleared in the opposite direction. 

♦ A block in the route is not signaled in the same direction as the requested route (see Paragraph 3.5.1). 

♦ A train occupies the first block in the route. 

♦ A block in the route has an active block permit (Track and Time) (see Paragraph 7.7). 

6.2.2. Signal Fleeting 
Each time a train advances beyond a signal, the signal will go to stop.  If another train is following, the 
dispatcher has to re-clear the signal.  A signal fleeting function is provided to help the dispatcher.  This function 
automatically re-clears the signal as soon as the train that initially passed the signal no longer occupies the first 
block beyond the signal. 

Only signals with long masts can be fleeted (see Figure 16).  To fleet a signal, place the mouse pointer on the 
signal and click the right mouse button.  A pop-up menu will appear which will have a “Fleet” menu item.  Select 
the “Fleet” menu item, and a gray signal ball will appear next to the green signal ball to indicate the signal is now 
fleeted. 

Fleeted

 

Figure 16 - Signal Fleeting 
Signals do not have to be cleared prior to being fleeted.  If the signal is at stop, Train Dispatcher 3 will 
automatically try to clear it. 
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To cancel signal fleeting, place the mouse pointer on the fleeted signal and click the right mouse button.  A pop-
up menu will appear which will have a “Remove Fleet” menu item.  Select the “Remove Fleet” menu item, and 
the gray signal ball will disappear. 

6.2.3. Running Time on a Signal 
Train dispatchers controlling a territory operating under Centralized Traffic Control are prevented from causing 
dangerous conditions because of safety procedures built into the system.  The most dangerous thing a 
dispatcher can do is drop a signal (turn it red) in front of train when, from information provided by previous 
signals, the locomotive engineer is not expecting to have to stop. 

The signaling system is designed to tell the locomotive engineer how many blocks are cleared ahead.  If a 
locomotive engineer suddenly sees a stop signal, when he is expecting to see a cleared one, he will probably 
place his train into emergency braking to attempt to stop the train from entering the next block.  Emergency 
braking is very dangerous and can cause the train to de-rail.  

The safety system assumes the train may not come to a complete stop until it has entered the block beyond the 
signal at stop.  The system will, therefore, not allow the dispatcher to change the switch positions in the route 
that was cleared until five minutes after the signal was dropped. The signal and route will blink on the track 
diagram when time is running on a signal. 

The program will only run time on a signal if the block in front of the signal is occupied by a train. 

6.2.4. Entrance-Exit Signal Commands 
To help the dispatcher set a route faster, some dispatching offices use a system where a dispatcher specifies a 
route’s entrance and exit signals, and the system automatically aligns the route (positions all the switches) and 
clears the signals.  This eliminates the need for the dispatcher to manually position each switch before clearing 
the signals. 

Train Dispatcher 3 also has this capability.  To specify an entrance-exit route place the mouse pointer on the 
signal which is the first signal in the route and click the right mouse button.  A popup menu will appear that has 
an “Entrance” menu item.  Select the “Entrance” menu item, and the signal will begin blinking.  Next find the 
signal where you want the route to end, place the mouse pointer on the signal, and click the left or right mouse 
button.  If Train Dispatcher 3 can find a path from the entrance to the exit signal it will try to clear a route.   If it 
cannot clear the route, an appropriate message will appear. 

In Figure 17, for the indicated entrance signal you can select any signal on the second or third track from the top 
of the figure as the exit signal.  Even signals that are for the opposite direction can be selected.  When an 
opposite direction signal is selected as an exit, the route will be cleared to the next signal that is in the same 
direction as the route.  

To cancel and entrance-exit request, after selecting the entrance signal, place the mouse pointer on any place 
on the screen that is not a signal and click the left mouse button. 

Entrance-exit requests will set up routes that go beyond just the next signal in the same direction.  The system 
will search for the exit signal up to 50 devices from the entrance signal.  A device is considered to be any track 
block, switch, diamond or connecting line.  In Figure 17 the number of devices from the entrance signal to the 
first signal to the right of the entrance signal on the second track from the top of the figure is 9. 
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Entrance Signal 
 

Figure 17 - Entrance-Exit Signal Commands 

6.2.5. Stack Route Commands 
There are many occasions when a dispatcher wants to clear a route as soon as a conflicting situation is 
resolved.  For example, a dispatcher wants to clear a train out of siding as soon as a train moving in the 
opposite position clears the mainline block in front of the siding   Without stacking, the dispatcher has to 
constantly monitor the situation until there is no longer a conflict and then clear the new route. 

Stacking allows the dispatcher to enter the next route to be cleared into the system.  As soon as the system 
sees that there is no longer a conflict, it will automatically clear the route by positioning the switches and 
clearing the signal. 

To set up a stacked route, place the mouse pointer on the signal you want to clear next and click the right 
mouse button.  A pop-up menu will appear.  Select the “Add Stack Command” and the signal will begin to blink 
in the same fashion as the entrance-exit command.  Next find the signal where you want the stacked route to 
end, place the mouse pointer on the signal, and then click the left or right mouse button.  If Train Dispatcher 3 
can find a path from the beginning to the ending signal it will give you a message that the stack command was 
added.  The stacked route will also be displayed in yellow.  Only those portions of the route that are currently 
unoccupied will be shown in yellow.  A number will also appear at the base of signal indicating the number of 
routes that have been stacked for that signal. 

Unlike entrance-exit commands, stack commands can only go to the next signal.  In Figure 17, if the signal 
shown as the entrance signal is specified as the beginning of a stacked route, there are only two signals that 
could be designated as the ending signal.  These are the first signals to the right of the entrance signal on the 
second and third tracks from the top of the figure. 

You can designate up to five stacked routes per signal.  The first stacked route you enter will be the next route 
cleared when the current conflict is resolved.  To see a list of stacked routes place the mouse pointer on the 
signal and click the right mouse button.  A pop-up menu will appear which will have a “Delete Stack Command 
XXX (entrance signal name) – (exit signal name)” menu item for each stacked route.  To close the pop-up 
menu, place the mouse pointer at any location outside the pop-up menu and click the left mouse button. 

To delete a stack command, select the appropriate “Delete Stack Command” menu item. 

6.2.6. Automatic Signaling of Diamonds 
Diamonds can be automatically signaled.  This means that routes can be cleared across a diamond in both 
directions at the same time.  If conflicting routes are cleared across a diamond the first train that hits the 
approach track to the diamond will be cleared to proceed across the diamond.  The signals governing the 
diamond for the other routes will automatically go to stop until the diamond is no longer occupied by the first 
train, at which time the next train to arrive at the approach track to the diamond will be cleared to proceed. 

If the diamond is not set to be automatically signaled, only one route across the diamond can be cleared at any 
given time. 

To determine if a diamond is automatically signaled, place the mouse pointer on the diamond and look at the 
diamond’s parameters in the Status Display line. 
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6.3. Train Speeds 
The safety system determines the speeds trains shall travel.  Because locomotive engineers usually can not see 
far enough ahead to know if they must soon stop, they must rely on the signaling system to tell them how fast 
they should be going.  The wayside signals will tell the engineer how many blocks ahead are cleared for his 
train.  Most systems have three aspects, which indicate the condition of the next two blocks.  The three aspects 
are stop, clear to proceed through the next block preparing to stop at its end, and clear to proceed through the 
next two blocks.  Train Dispatcher 3 is designed to handle up to four aspects, which gives the engineer 
information about the next three blocks. 

The speed a train travels through a block depends on the type of train and the number of blocks that are cleared 
ahead of the train.  To display the train speeds for a particular block, follow the instructions in Paragraph 3.5.1. 

6.4. Train Commands 
Train Dispatcher 3 allows the user to issue commands directly to a train crew.  The following is the list of 
commands: 

♦ Stop the train now 

♦ Stop the train in block XXX 

♦ Start the train 

♦ Clear stop train request 

♦ Pass next red signal 

♦ Reverse the train 

♦ Change the crew in block XXX 

♦ Split train 

♦ Merge train with train XXX 

To issue commands to a particular train, place the mouse pointer on the block that contains the train and click 
the right mouse button.  A pop-up menu will appear with a list of menu item representing the commands that 
currently can be issued to the train.  If there is more than one train in the block, the commands available for 
each train in the block will be listed.  Only currently valid commands for each train will be listed.  For example, if 
the user has not manually stopped a train, the “Train XXX Start Movement” menu item will not appear.  If the 
train has been manually stopped, the “Train XXX Stop Now” will not appear. 

The following is a description of the train commands: 

6.4.1. Train XXX Stop Now Command 
The “Train XXX Stop Now” menu item command causes the designated train to stop as soon as possible.  This 
menu item will always appear in the pop-up menu unless this command or the “Train XXX Stop in Block” 
command has already stopped the train. 

Once the train is manually stopped the only way to start the train is to issue the “Train XXX Start Movement “ 
menu item command. 

6.4.2. Train XXX Stop in Block Command 
The “Train XXX Stop in Block” menu item command causes the designated train to stop in the designated block.  
The train will always stop at the far end of the block.  When this menu item is selected a dialog will appear with a 
list of blocks in which you can command the train to stop. 

Once the train is manually stopped the only way to start the train is to issue the “Train XXX Start Movement “ 
menu item command. 
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6.4.3. Train XXX Start Movement Command 
The “Train XXX Start Movement Now” menu item command causes the designated train to start moving as soon 
as possible.  This menu item will only appear in the pop-up menu if the train is stopped because the “Train XXX 
Stop Now” or the “Train XXX Stop in Block” commands have previously been issued for the train. 

6.4.4. Train XXX Clear Stop in Block XXX  
The “Train XXX Clear Stop in Block XXX” menu item command causes a previous instruction to stop the train in 
a designated block to be cancelled.  This menu item will only appear in the pop-up menu when a train has been 
issued a “Train XXX Stop in Block” command. 

6.4.5. Train XXX Pass Red Signal Command 
The “Train XXX Pass Red Signal” menu item command causes the designated train to move past the next red 
signal.  There are several reasons why a dispatcher may want to instruct the crew to “go through” a red signal.  
The two most common are to allow the train to pass a signal “stuck” on red due to signal failure and to allow a 
train to proceed into a block already occupied by another train traveling in the same direction.  This second 
reason is important if two trains are going into a merge.  For example, if a train requires a helper to move up a 
hill, the helper would have to move past a red signal in order to get into the block that is occupied by the train 
needing the helper.  Once in the block and stopped behind the other train, the helper can be connected to it by 
use of the “Train XXX Merge” menu item command. 

This menu item will only appear in the pop-up menu when a train is stopped waiting for a signal. 

6.4.6. Train XXX Reverse Train Command 
The “Train XXX Reverse Train” menu item command causes the designated train to stop and start movement in 
the reverse direction as soon as possible.  This menu item will always appear in the pop-up menu unless the 
train has been manually stopped or there is another pending reverse request. 

Trains cannot be reversed if there is opposing traffic in the reverse direction between the train and the next 
control signal or the track behind the train is not signaled in the reverse direction. 

6.4.7. Train XXX Change Crew Command 
The “Train XXX Change Crew” menu item command instructs the train to stop in a designated block and wait for 
the new crew to arrive.  It also calls the new crew. 

When this menu item is selected it causes the Call Crew dialog in Figure 18 to appear. 

 

Figure 18 - Crew Call 
The block in which the crew exchange is to occur must be selected.  The time the new crew will arrive will be 
determined by the crew’s call time entered in this dialog and the time it takes the new crew to travel to the block.  
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The time it takes for a crew to get to a block can be found in the Block Properties – General dialog (see 
Paragraph 3.5.1). 

When information in the Call Crew dialog is successfully entered, the time the new crew will arrive in the block 
will be displayed.  See Paragraph 6.8 for more information about the crew calling and crew time expirations. 

6.4.8. Train XXX Merge with Train XXX Command 
The “Train XXX Merge with Train XXX” menu item command causes the designated train to merge with another 
train.    This menu item will appear in the popup menu when the designated train is behind another train in the 
same block and both trains are stopped. 

Once two or more trains are merged together, they can be split apart by the “Train XXX Split” command. 

6.4.9. Train XXX Split Command 
The “Train XXX Split” menu item command causes the designated train to be split into two trains.    This menu 
item will appear in the popup menu when the designated train has been previously merged with another train. 

When this menu item is selected a dialog will appear which asks which train is to be split from the designated 
train. 

6.4.10. Use of Helper Trains 
Two trains are sometimes connected together or merged for various reasons.  The most common reason to 
merge two trains is to facilitate the use of a “Helper” train to power a second train over a steep grade.  Because 
of the safety controls that are a part of CTC, the merging of two trains requires several steps.  The CTC circuitry 
normally will prevent two trains from occupying the same block at the same time.   

When a heavy train encounters a grade it cannot traverse it will stop, and its status will indicate the train is 
stopped waiting for a helper.  The trains in a particular territory that are available as helpers can be seen in the 
Active Train List Window.  A train designated as a helper must be maneuvered to the block immediately behind 
the block containing the train needing more power.  The helper will automatically stop when it encounters the 
red signal at the entrance to the block containing the other train.  The dispatcher can instruct the helper to go 
through the red signal and into the block by right clicking on the train and selecting the “Train XXX Pass Red 
Signal” menu item.  The train will then proceed into the block and stop behind the other train.  Once the helper is 
stopped behind the other train, the dispatcher can instruct the two trains to merge by right clicking on the helper 
and selecting the “Train XXX Merge with Train XXX” menu item.  The two trains will henceforth move as one 
train and assume the train identifier of the original forward train. 

After the grade has been traversed the merged train can be split into the two original trains by right clicking on 
the train and selecting the “Train XXX Split” menu item.  The original helper train will reassume its original train 
identifier, and the two trains will once again move as two distinct trains obeying all of the CTC circuitry.            

6.5. Trains at Junctions 
Diamonds are often used at junctions with a foreign railroad.  Trains moving across the junction are often 
controlled by another railroad and can have a serious impact on dispatching operations. 

Train Dispatcher 3 simulates the impact of these trains by specifying how often a train controlled by another 
dispatcher will cross the junction.  Diamonds that are partially controlled by another dispatcher do not have any 
signals in the route across the diamond that the other dispatcher controls.  In Figure 19, another dispatcher 
controls the route that crosses the diamond at Branchville from top to bottom. 
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Figure 19 - Diamond Train Frequency Example 
 

To display the frequency of foreign trains across the diamond, place the mouse pointer on the diamond.  The 
train frequency over the diamond will appear in the status display line.  In this case Train Dispatcher 3 would 
automatically clear and move 2 trains a day across this junction.  Each train’s route would be cleared 5 to 15 
minutes before the train arrived and be occupied for 2 to 5 minutes. 

6.6. Permission to Enter Territory 
A number of entrance/exit locations require the dispatcher to give the train permission before it can enter the 
territory.  To determine if an entrance/exit location requires trains to obtain permission before entering the 
territory, place the mouse pointer on the entrance/exit location name.  The status display line will display 
information about the entrance/exit location including whether trains must obtain permission to enter the territory 
at that location. 

When a train requests permission to enter the territory the dialog in Figure 20 will appear. 

 

Figure 20 - Train Entry Request Dialog 
The request can either be granted for a specified time or can be delayed until later.  If delayed, the train will 
make another request in 30 minutes. 

The train entry request function can be de-activated.  See Paragraph 8.3 about turning off this function. 
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6.7. Block Permit Request 
Tracks often require maintenance.  Before maintenance can be performed, the track must be taken out of 
service.  To take a track out of service, the dispatcher issues a block permit (track & time).  The block permit 
authorizes a maintenance gang to work on the track for a specified amount of time. 

When a foreman wants to obtain a block permit he will issue a request to the dispatcher.  When a request is 
made in Train Dispatcher 3, the dialog in Figure 21 will appear. 

 

Figure 21 - Block Permit Request Dialog 
The dispatcher can either ask the foreman to request the permit again or authorize it for a specific time period.  
If the foreman is not granted time, he will make another request in 30 minutes. 

If time is granted, but not for the total amount requested, the foreman will make another request after the first 
permit that was granted has expired. 

6.8. Crew Calling 
Train crews are only allowed to be on duty for 12 hours.  If a train crew’s on-duty time exceeds 12 hours (crew‘s 
time expires), the train will stop and will not move again until a new crew arrives and replaces the current train 
crew. 

It is the job of the dispatcher to call replacement crews and to prevent train crews from expiring on the mainline. 

The time a train’s crew will expire can be found in the Active Train List window (see Paragraph 7.2) or in the 
train’s status line display at the top of the screen, which is seen when the mouse pointer is positioned on the 
block containing the train. 

A new crew for a train can be called at anytime and be scheduled to replace a train’s crew at a platform or in a 
specified block.  The time it takes for a crew to arrive at a platform or block is determined by the time the crew 
was called plus the travel time to the block.  There is a field in each block’s Block Properties – General dialog 
that contains the amount of time it takes to get a new crew to the block. 

A crew’s on-duty time starts when the dispatcher calls the crew. 

7. SIMULATION STATUS INFORMATION 
Train Dispatcher 3 provides a considerable amount of information about the status of a simulation.  Most of this 
information is centered around the status of trains, but also addresses block permits and slow orders.  The 
following describes various functions that provide status information. 
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7.1. Train Status Line 
To quickly find information about a train, place the mouse pointer on the train.  The train’s status will appear in 
the status display line near the top of the screen (see Figure 22) 

 

 
Figure 22 - Train Status Line 

The train status line contains the following information: 

♦ The train identifier 

♦ The average speed of the train in the block 

♦ The length of the train 

♦ The next entrance/exit location where the train is to leave the territory or the train identifier of the 
train this train will become 

♦ The status of the train (i.e. “moving forward”); 

♦ The train’s next scheduled event 

o if the train is moving, the time it will arrive at the end the block 

o if the train is at stop waiting for a signal, the time it stopped 

o for all other train stops (platform, work area, etc.), the estimated time of departure. 

♦ The time when the crew will expire because they have worked 12 hours. 

♦ If a new crew has been called, the place and time the crew change will occur  

7.2. Active Train List 
Trains that are on the territory and are due to arrive on the territory in 8 hours appear in the Active Train List 
window.  To call up the Active Train List window, select “Trains" in the menu bar, and the display in Figure 23 
will appear. 

 

Figure 23 - Active Train List Window 
This window is dynamically updated.  As trains move and their status change, the window will be modified to 
reflect these changes.  To stop this window from updating click the “Stop” button to stop the simulation clock. 



Train Dispatcher 3.5 

 Page 28  
14 November, 2003 

The list can be sorted by train identifier, train status or by estimated time of arrival/departure (ETA).  To sort by 
train identifier, status, or ETA click the “Sort ID”, “Sort Status” or “Sort ETA” buttons, respectively. 

To display only the trains that are scheduled to arrive on the territory, are stopped, are moving, or are off the 
territory and will not return, check the “Arriving”, “Stopped”, “Moving” or “Completed” boxes, respectively.  

The user can re-size any of the columns in this window by placing the mouse on a vertical separator in the 
columns header and, while holding down the left mouse button, drag the mouse to the left or right.  Once the 
columns are re-sized, the user can save the column widths for the next time the window is displayed by clicking 
the “Save Column Widths” button. 

The following describes each of the columns in this window: 

♦ Train ID - contains the train identifier. 

♦ Status - contains a text description of the train’s current status. 

♦ Length - contains the train length in feet/meters. 

♦ Type - indicates the type of train. 

♦ Location - contains the name of the track where the train is currently located. 

♦ Direction - indicates the train’ s current direction. 

♦ Speed - the average speed in which the train is moving in the current block. 

♦ ETA - the following describes the contents of this field 

o if the train is moving, the time it will arrive at the end the block 

o if the train is scheduled to arrive, the time it will arrive on the territory 

o if the train is at stop waiting for a signal, the time it stopped 

o for all other train stops (platform, work area, etc.), the estimated time of departure. 

♦ Crew Expiration - the time the crew will expire because it was on duty for 12 hours. 

♦ Entrance - contains the entrance/exit location where the train came onto the territory the last time. 

♦ Exit - contains the entrance/exit location where the train should exit the territory. 

♦ Next Station Stop/Time - contains the name of the next station platform and the time the train is 
scheduled to stop at the platform. 

♦ Part of Train – if the train is merged with another train, the train identifier of the merged train. 

To locate a train on the territory, place the mouse pointer on any of the data contained in a train’s row, click the 
left or right mouse button to select the train, and then click the “Find” button.  Train Dispatcher 3 will then scroll 
on the territory screen to the location of the train and place the mouse pointer on the train. 

The train’s data dialog can be called up by placing the mouse pointer on any data contained in a train’s row, 
clicking the left or right mouse button to select the train, and then clicking the “Properties” button. 

Train Dispatcher 3 keeps a record of train movements by recording the time a train passes an OS point (OS is 
sometimes referred to as on-station or out of station). 

OS point names are usually assigned to the switches at each end of a siding or to blocks in the middle of a 
siding.  The number and location of the OS points are determined by the railroad.  A list of the OS points can be 
called up by selecting the “OS Points” item under the “Data” menu. 

The train’s OS window can be called up by placing the mouse pointer on any data contained in a train’s row, 
clicking the left or right mouse button to select the train, and then clicking the “OS” button.   Figure 24 shows the 
Train OS window. 
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Figure 24 - Train OS Window 

7.3. Train Territory Arrival Schedule 
A list of trains that are to arrive on a territory at a given entrance/exit location can be called up placing the 
mouse pointer on the entrance/exit location name and clicking the right mouse button.  Figure 25 will then 
appear. 

 

Figure 25 - Train Territory Arrival Window 
This window shows the trains that will arrive on the territory in the next eight hours.  The trains are sorted by 
their arrival time. 

The user can re-size any of the columns in this window by placing the mouse on a vertical separator in the 
columns header and, while holding down the left mouse button, drag the mouse to the left or right.  Once the 
columns are re-sized, the user can save the column widths for the next time the window is displayed by clicking 
the “Save Column Widths” button. 

The train’s data dialog can be called up by placing the mouse pointer on any data contained in a train’s row, 
clicking the left or right mouse button to select the train, and then clicking the “Properties” button. 

Multiple Train Territory Arrival windows for different entrance/exit locations can be opened at the same time.  
These windows will automatically update as the status of trains change. 

7.4. Train Platform Schedule 
A list of trains scheduled to stop at a platform can be called up placing the mouse pointer on a block containing 
the platform and clicking the right mouse button.  Click on the “Train Stop at Platform” item in the pop-up menu 
that will appear, and the window shown in Figure 26 will be displayed. 
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Figure 26 - Train Platform Schedule Window 
This window shows the trains that will be stopping at the platform in the next eight hours.  The trains are sorted 
by their scheduled platform departure time. 

The user can re-size any column in this window by placing the mouse on a vertical separator in the columns 
header and, while holding down the left mouse button, drag the mouse to the left or right.  Once the columns are 
re-sized, the user can save the column widths for the next time the window is displayed by clicking the “Save 
Column Widths” button. 

To locate a train on the territory, place the mouse pointer on any of the data contained in a train’s row, click the 
left or right mouse button to select the train, and click the “Find” button.  Train Dispatcher 3 will then scroll on the 
territory screen to the location of the train and place the mouse pointer on the train. 

The train’s data dialog can be called up by placing the mouse pointer on any data contained in a train’s row, 
clicking the left or right mouse button to select the train, and then clicking the “Properties” button. 

7.5. Train Graph 
A historical record of train movements can be displayed in the form of a train graph.  The train graph is a 
graphical representation of train movements obtained by plotting the time each train hits an OS point.  To 
display the train graph select the “Display Train Graph" item under the “View” menu (see Figure 27).  
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Figure 27 - Train Graph 
The train graph plots each train.  The OS points are indicated on the left side of the display and time across the 
top.  Dots indicate when an actual OS time was recorded for the train.  Each train is assigned a color, and the 
train’s identifier is displayed above alternating OS hits. 

To change the size of the train graph, modify the pixel widths in the “OS Spacing” (height) and “Hour Spacing” 
(width) fields at the top of the screen, and then click the “Resize” button. 

7.6. Performance Data 
The performance of individual trains can be monitored.  To view train performance, select the “Display 
Performance” item under the “View” menu, and the window shown in Figure 28 will appear.  

 

Figure 28 - Performance Window 
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This window displays the total performance of the system (first row) and the individual performance of each 
train.  The train performance is sorted by the train identifier.  The following describes the columns in this 
window: 

♦ Train ID - the train identifier. 

♦ Miles - the total number of miles the train has traveled. 

♦ Stop Time - the amount of time the train has been stopped either waiting for a signal to clear or due to 
crew expiration. 

♦ Lost Time - the amount of time that was lost because the train was not moving at its maximum speed. 

♦ Late Departure Time - the amount of time the train was late in departing station platforms. 

♦ Late Departure - the number of times the train was late departing station platforms. 

♦ Missed Exits – the number of times the train departed the territory at the wrong entrance/exit location. 

7.7. Active Block Permits 
Block permits that are active, authorized by the dispatcher and not active, or to be requested within 8 hours 
(pending) can be viewed in the Active Block Permit List window.  To call up the Active Block Permit List window 
select the “Permit" item in the menu bar, and the window in Figure 29 will appear. 

 

Figure 29 - Active Block Permit List Window 
This window is dynamically updated.  As the status of block permits change, the window will continually be 
modified to reflect these changes. 

The list can be sorted by track name or the permit’s requested or actual start time.  To sort by the track name or 
the permit’s requested or actual start time click the “Sort Track” or “Sort Time” buttons, respectively. 

To display just the block permits that are pending, authorized or active, check the “Pending”, “Authorized” or 
“Active” boxes, respectively.  

The user can re-size any column in this window by placing the mouse on the vertical separator in the columns 
header and, while holding down the left mouse button, drag the mouse to the left or right.  Once the columns are 
re-sized, the user can save the column widths for the next time the window is displayed by clicking the “Save 
Column Widths” button. 

The following describes each of the columns in this window: 

♦ Number - contains the internal system number of the permit. 

♦ Status - contains the status of the permit. 

♦ Track Name - contains the name of the track that will be protected by the permit. 
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♦ From Time - contains the requested or actual time the permit will start. 

♦ To Time - contains the requested or actual time the permit will end. 

♦ Time Still needed - the amount of time the requestor still needs after the currently authorized or active 
permit ends. 

♦ Requestor - the name of the person requesting the block permit. 

♦ Reason - the reason for the request. 

To authorize a pending block permit request, place the mouse pointer on any of the data contained in a block 
permit’s row, click the left or right mouse button to select the block permit, and click the “Authorize” button.  The 
Block Permit Request dialog in Figure 21 will then appear. 

7.8. Active Slow Orders 
Slow orders that are active or will occur within 8 hours (pending) can be viewed in the Active Slow Order Permit 
List window.  To call up the Active Slow Order List window select the “Slow Order" menu item in the menu bar, 
and the window in Figure 29 will appear. 

 

Figure 30 - Active Slow Order List Window 
This window is dynamically updated.  As the status of slow orders change, the window will be continually 
modified to reflect the changes. 

The list can be sorted by track name or the slow order’s requested or actual start time.  To sort by the track 
name or the slow order’s requested or actual start time, click the “Sort Track” or “Sort Time” buttons, 
respectively. 

To display only the slow orders that are pending or those that are active, check the “Pending” or “Active” boxes, 
respectively.  

The user can re-size any of the columns in the window by placing the mouse on a vertical separator in the 
columns header and, while holding down the left mouse button, drag the mouse to the left or right.  Once the 
columns are re-sized, the user can save the new column widths for the next time the window is displayed by 
clicking the “Save Column Widths” button. 

The following describes each of the columns in this window: 

♦ Number - contains the internal system number of the slow order. 

♦ Status - contains the status of the slow order. 
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♦ Track/Block/Switch Name - the name of the track, block or switch that is affected by the slow order. 

♦ Permanent – indicated if the slow order is permanent or has a limited time period. 

♦ From Time - the time when the slow order goes into effect. 

♦ To Time – the time the slow order expires. 

♦ Slow Order Speeds – is a group of fields for each type of train in each direction, which contains the 
maximum speeds the trains can travel over the track, block or switch when the slow order is in effect.  If 
the speed for a train type is blank, the slow order does not affect the speeds for that type of train. 

7.9. Alert System 
Centralized Traffic Control systems generally allow dispatchers to view their entire territories at one time by 
using several monitors or a wall board.  Because most computers only have one monitor, Train Dispatcher 3 
cannot, in some cases, display the entire territory on a single screen even if the track diagram is zoomed out 
and the monitor is set at its highest resolution. 

To help the user, Train Dispatcher 3 has a message alert system, which informs the user of situations that may 
require his or her attention.  The system can generate an alert message for any of the following situations: 

� When a train arrives on the territory 

� When a train is stopped waiting at a signal 

♦ When a train is stopped because of a wayside defect detector alarm 

� When a block permit will become active in 30 minutes 

♦ When a block permit becomes active 

♦ When a slow order becomes active 

♦ When a train is late arriving at a passenger station 

♦ When a train has locomotive problems which affect the train’s performance 

♦ When a train is having problems that require it to stop 

♦ When a train’s crew will expire in two hours 

♦ When a train’s crew expires 

The user can decide which alert messages will be generated and whether they will have an associated audio 
alarm (see Paragraph 8.2). 

Alert messages will appear in the status line near the top of the screen (see Figure 31) if the mouse pointer is 
not placed on a train, track block, switch, diamond, or signal.  If the mouse pointer is on any one of these items, 
instead of the alert message, information on that item will be displayed in the status line. 

 

Figure 31 - Alert Messages 
The alert displayed in the status line is either the last alert that occurred or the last alert the user looked at.  To 
set this option to be the last alert that occurred, select the “Display Last Alert” menu item under the “View” 
menu.   

There are three buttons located above the status line that are associated with the alert system.  These are the 
“Prev Alert”, “Next Alert” and  “Go to Alert”.  The program saves a list of the 50 most recent alert messages.  
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Each alert message is assigned a sequential number.  If there is an alert message after the one that is currently 
being displayed in the status line, the “Next Alert” button will be active (not gray).  To display the next alert 
message, click the “Next Alert” button.  If there is an alert message previous to the one being displayed, the 
“Prev Alert” button will also be active. 

Clicking on the “Go to Alert” button will cause the mouse pointer to be positioned on the territory screen at the 
location (train or track block) that caused the alert condition displayed in the status line.   

The alert system can also display a window that shows all 50 of the alert messages currently saved in the 
system.  To display the Alert Message window (see Figure 32), click on the “Display Alert Window” item in the 
“View” menu.  The alert that is displayed in the status line will be highlighted in the window that appears.  To go 
from this window to the device that caused the alert message double click (using the left mouse button) on the 
message. 

 

Figure 32 - Alert Message Window 

8. OPTIONS 
Train Dispatcher 3 has a number of options that can be selected to vary a simulation.  These options are broken 
down into three categories.  These categories specify the randomness of a simulation, the alert parameters, and 
which functions are to be active. 

8.1. Random Performance 
To make each simulation different and more realistic, a random performance generator is included in Train 
Dispatcher 3.  The user controls the effect of the random performance generator by entering various 
parameters.  There are three types of random performance parameters:  train; wayside defect detector; and 
switch and signal.   

8.1.1. Random Train Parameters 
To enter the train parameters for the random performance generator, select the “Random Train Parameters” 
menu item under the “Random” menu.  Figure 33 will appear. 
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Figure 33 - Random Train Parameters Dialog 
For each train type the user can define a range of randomness for performance, delays, and failures.  The 
following describes each of the fields in the Random Train Parameters dialog: 

♦ Run Time Performance - Even though the signaling system and operating rules dictate how fast a train 
should travel, locomotive engineers operate differently.  This parameter sets by how much train speed 
will deviate from expected speed.  If this field is set to 10, for example, the trains’ speeds will deviate +-
10% from the expected speed.  A train, therefore, with an expected speed of 60 miles per hour will be 
assigned a random speed between 54 and 66 miles per hour.  If this parameter is set to zero, the trains 
will always travel at the expected speeds. 

The random speed deviation for a particular train type applies from the time it enters the territory until it 
exists the territory.  Therefore, a train will travel through all blocks at the same percentage deviation 
from the expected speed. 

♦ Startup Delays - Stopped trains do not always immediately start to move when a signal is cleared.  The 
train startup time can be affected by the weight of the train, the slope of the track, and the locomotive 
engineer’s response time.  When this parameter is checked, a random startup time for the train will be 
generated based on the normal start up time for that train type. 

♦ Late train arrival - Trains will not always arrive on the territory at the scheduled time.  This parameter 
sets the percentage of trains that will be late arriving on the territory.  If this parameter is set to zero, all 
trains will arrive on the territory on time. 

The amount of time a train can be late deviates from 1 minute to 9 hours and 59 minutes.  The algorithm 
used to calculate the lateness of a train causes lower time delays to be assigned more often than higher 
ones.  For example, 50% of all time delays will be less than one hour, 75% less than 2 hours, 87.5% 
less than 3 hours, etc. 

♦ Locomotive Problems – Trains can have problems with one or more of their locomotives that will affect 
the performance of the train.   The number entered into this parameter indicates the percentage of trains 
on the territory that will have locomotive problems.  For example, if this parameter set to 0, none will; if it 
is set to 50, then 50 percent of the trains will develop locomotive problems. 

♦ Train Problems – Trains can have problems such as broken air hoses.  When a problem of this type 
occurs the train must stop and the crew will have to fix the problem before it can move again.  As above, 
the number entered into this field indicates the percentage of trains on the territory that will have this 
type of problem. 
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♦ Dropped Signal Derailment - One of the most dangerous things a train dispatcher can do is drop a 
signal (abruptly change the signal from cleared to stop) in front of a moving train.  This parameter 
determines the percentage of trains moving at speeds greater than 35 miles per hour that will be de-
railed if the dispatcher drops a signal in front of them.  For trains traveling less than 35 miles per hour, 
the percentage that will de-rail will be half of this parameter.  Trains already stopped when a signal is 
dropped will obviously not be de-railed. 

 Derailed trains will be stopped for a period of between 2 and 10 hours. 

8.1.2. Random Defect Detector Parameters 
To enter the defect detector parameters for the random performance generator, select the “Random Defect 
Detect Parameters” item under the “Random” menu.  Figure 34 will appear. 

 

Figure 34 - Random Defect Detector Parameters Dialog 
 

For each type of wayside defect detector the user can define a range of randomness for alarms and false 
alarms.  The following describes each of the fields in the Random Defect Detector Parameters dialog: 

♦ Alarms - A number of track blocks may contain wayside defect detectors.  Trains passing through these 
blocks will be scanned for problems and an alarm will be generated if a problem is detected.  This 
parameter determines the number of times a problem be detected for every 1000 trains scanned.  If an 
alarm is generated the crew will stop the train, walk to the car that is the subject of the alarm, and 
determine if the alarm was real or false.  This process will cause the train to be stopped for a period of 
time based on the distance from the front of the train to the car that caused the alarm. 

♦ False Alarms - Not all alarms are real.  A number of them are false.  This parameter sets the 
percentage of alarms that are false.  If the alarm is false, the train will restart immediately after the car is 
checked.  If the alarm is real, the train will be stopped for an additional period of time while the crew 
corrects the problem.   
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8.1.3. Random Switch and Signal Failure Parameters 
To enter the switch and signal failure parameters for the random performance generator, select the “Random 
Switch and Signal Failure Parameters” item under the “Random” menu.  Figure 35 will appear. 

 

Figure 35 - Random Switch and Signal Failure Parameters Dialog 
 

The user can define a range of randomness for switch and signal failures.  The following describes each of the 
fields in the Random Switch and Signal Failure Parameters dialog: 

♦ Switch failures - Switches sometimes fail to throw because of mechanical problems or debris located 
near the switch points.  This parameter determines the number of switch failures that will occur for every 
1,000 switch throws.  If a switch fails to throw, the dispatcher will make several attempts to throw it 
again and hope the movement of the points will dislodge any debris.  Train Dispatcher 3 is designed to 
recover from a switch failure 50% of the time on the first attempted throw after the switch failure, 25% on 
the second attempted throw, 12.5% on the third throw, etc.  The user will be asked if a maintainer 
should be called to correct the problem. 

The user can also tell the crew of a train stopped near the switch to manually throw the switch.  To 
request a crew to manually throw a switch, place the mouse pointer on the failed switch and click the 
right mouse button.  This will cause a pop-up menu to appear with a “Crew to throw Switch XXX 
Manually” menu item.  Select this menu item to throw the switch in the opposite direction. 

Please note that this menu item will not appear if there is no train stopped near the switch. 

♦ Signal failures – Signals will sometimes fail to clear.  This parameter determines the number of signal 
failures that will occur for every 1,000 attempts to clear the signal.  If a signal fails to clear, the 
dispatcher will make several attempts to clear it again.  Train Dispatcher 3 is designed to recover from a 
signal failure 50% of the time on the first attempt to clear after the signal failure, 25% on the second 
attempted throw, 12.5% on the third throw, etc.  The user will be asked if a maintainer should be called 
to correct the problem. 

While waiting for a maintainer to fix a signal stuck on red, the user can allow trains to pass the failed 
signal.  For more about this  see Paragraph 6.4.5. 

♦ Time for maintainer to arrive – It takes a certain amount of time for a maintainer to arrive and fix the 
problem.  In this field the user specifies, in minutes, this amount of time.  

♦ Random maintainer arrival time – The amount of time it takes for a maintainer to arrive and fix a 
problem is not always constant.  This field allows the user to specify limits on the randomness of the 
arrival time.  If 50% is entered into this field and the maintainer’s arrival time is 2 hours, then the random 
arrival time will be between 1 and 3 hours. 
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8.2. Alert Options 
There are a number of alert messages that can be activated or de-activated by the user.  The user can select 
which alert messages are active and if they will produce an audio alarm.  The audio alarm can either use the 
computer’s internal bell or a sound card.  To select the alert options, click the “Alert Parameters” item under the 
“Options” menu.  Figure 36 will appear. 

 

Figure 36 - Alert Parameters Dialog 
The following describes the fields in this dialog: 

♦ Alerts - Each type of alert message can be turned on or off by clicking the appropriate “Yes” check box.  
If the “Yes” box is checked for a particular alert message, an alert message will be issued any time the 
condition exists.  For any alert message conditions that do not have the “Yes” box checked, alert 
messages will not be issued. 

♦ Bells - Sounds can also be generated when an alert message is issued.  If the computer’s internal bell 
is used, a number greater than zero should be entered in the appropriate “Bell” field indicating how 
many times a bell will chime as an alert to the dispatcher of the alert condition. 

Please note that sometimes the internal bell is turned off if the computer has a sound card installed.  
Please refer to your computer’s setup function (not the Window’s Setup function) if the internal bell fails 
to sound. 

Please also make sure that the sound in Train Dispatcher 3 is turned on by clicking the “Turn on Sound” 
button in the toolbar near the top of the screen. 

♦ Sound File - If a sound card is installed in the computer, unique sounds for each alert condition can be 
generated by entering a wave file name (files with an extension of “.wav”) in the “Sound File” field.   

If the computer has a sound card, a number of wave files are usually provided by one of the vendors 
and are located in the windows or windows/media folder.  To find these files, use the “Browse” button 
next to the “Sound File” field. 
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If you cannot find any .wav files, click the Window’s “Start” button, select the “Find” menu item, select 
the “Files or Folders” menu item, enter “*.wav” in the “Named” field and click the “Find Now” button.  A 
list of .wav files should appear and indicate in which folders they reside on the disk. 

With a sound card, users can also generate their own sound files that contain verbal messages (check 
the documentation which accompanied the sound card for more information). 

♦ Late station departure – the user can also specify, in this dialog, how many minutes beyond a 
scheduled departure time a train can fail to depart a platform before an alert is generated. 

8.3. Function Activation 
Train Dispatcher 3 tries to accurately simulate a dispatcher’s operation.  This can sometimes be overwhelming 
to a novice.  To make it simpler to simulate a territory, Train Dispatcher 3 allows the user to turn off various 
functions. 

To activate or de-activate these optional functions, click the “Function Activation” menu item under the “Options” 
menu.  Figure 37 will appear. 

 

Figure 37 - Function Activation Dialog 

9.  TERRITORY DATA 
The user can view data in a loaded track territory file by selecting one of the menu items under the “Data” menu.  
A Train Dispatcher 3 user can also modify some data in the track file.  The Train Dispatcher 3 user can modify 
train, block permit, and slow order data.  Data about the track structure or speed restrictions cannot be changed. 

If the user changes track file data, a new track file can be created that contains the user changes.  To save a 
modified track file, select the “Save Territory Track File” menu item under the “File” menu.  This action will not 
overwrite the original track file. 

The following describes the various track file data areas: 

9.1. Territory Data 
Data about the territory that can be viewed by the users is included in Train Dispatcher 3.  To view this 
information, select the “About Territory” item under the “Data” menu in the menu bar.  Figure 38 shows the 
dialog this menu selection produces. 
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Figure 38 -Territory Data Dialog 
Train Dispatcher 3 does not have the “Comments” field that was in Train Dispatcher 2.  To provide greater 
flexibility Track Builder 3 users can attach a comments file to the track file.  When Train Dispatcher 3 loads a 
track file it generates the comments file. This file is a text file (.txt file extension) and can be generated by any 
word processing application or Window’s NotePad or WordPad programs. 

To open the comments file, click the “Open” button, and the NotePad program will start and display the 
comments file.  A sample of what this display might look like is shown in Figure 39,  

 

Figure 39 - Territory Comments File 
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9.2. Train Type Descriptions 
Trains can be designated as one of ten types.  To view the train types select the “Train Type Description” item 
under the “Data” menu in the menu bar at the top of the screen.  The Train Type Data Window in Figure 40 will 
appear. 

 

Figure 40 - Train Type Data Window 
This window displays information about all of the train types.  The user can re-size any column in this window by 
placing the mouse on a vertical separator in the columns header and, while holding down the left mouse button, 
drag the mouse to the left or right.  Once the columns are re-sized, the user can save the column widths for the 
next time the window is displayed by clicking the “Save Column Widths” button. 

To edit a train type, first place the mouse pointer on the train type row and click the left button to select 
(highlight) the train type.  Then click the “Edit” buttons.  The “Edit” button will cause the Train Type dialog to 
appear (see Figure 41). 

You can also place the mouse on the train type row and click the right mouse button, which will also cause the 
Train Type dialog to appear. 

The only fields that can be changed in this dialog are the “Locomotive left bitmap file”, the “Locomotive right 
bitmap file” and the “Caboose bitmap file” fields. 

 

Figure 41 - Train Type Dialog 
The following describes each of the fields in the dialog: 

♦ Description – a description of the train type. 

♦ Type – a system description of the train type. 
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♦ Cabs at each end of train – is a check box that indicates the train has cabs on both ends and, 
therefore, has equal performance in both directions.  In Train Dispatcher 3 these trains are never 
considered to be moving in a reverse direction.  Trains that have dual cabs are usually transit vehicles 
or passenger trains. 

♦ Startup time – is the time it takes to get a train started if it was stopped waiting for a signal.  This field is 
used to assign for the train type the default startup time that appears in the Block Properties - Speeds 
dialog (see Figure 9). 

♦ Reverse speed – is the maximum speed of the train when it is moving in reverse. 

♦ Locomotive left bitmap file – custom icons can be added to the track execute file in Train Dispatcher 
3.  These icons are created from bitmap files that have a bitmap representing a left facing locomotive, a 
right facing locomotive, or a caboose.  These bitmaps must be 32 bits wide by 14 bits high and have no 
more than 16 colors.  A number of locomotive and bitmaps files are included with Train Dispatcher 3.  
The user should feel free to modify these. 

The data entered into this field is the name and location of the bitmap file.  To easily locate and enter 
this data click the “Browse” button. 

♦ Locomotive right bitmap file – see “Locomotive left bitmap file”.  

♦ Caboose bitmap file – see “Locomotive left bitmap file”.   

If the user changes the bitmap files for the locomotive or caboose icons, these new bitmaps will be displayed 
only after the track file is saved using the “Save Track Territory File” menu item under the “File” menu and then 
re-loaded using the “Change Territory Track File” menu item. 

9.3. Train Information 
Each territory has a considerable amount of data on each train.  Train Dispatcher 3 users can not only view this 
information but also change it and save the modified territory. 

Please note that changes made to the train information should be made prior to starting a simulation.  If 
changes are made after the simulation has started they will not affect any train that already appeared in the 
Active Train List window (see Paragraph 7.2).  The Active Train List window shows all of the trains that are on 
the territory and all of the trains that are scheduled to arrive on the territory in the next 8 hours. 

Train Dispatcher 3 breaks this data out into four data areas.  The following describes these areas: 

♦ General Information – contains general identification information about a particular train such as its 
type, length, the time and location of entry onto the territory, if it was created from another train, if it is to 
become another train, the days of the week it is scheduled to run, and where it is to exit the territory  

♦ Multiple Entries – contains specific information about a train that is to leave the territory and later 
return. 

♦ Work Schedule – contains specific information about a train that performs local work in a track area. 

♦ Passenger Schedule – contains specific information about when a train is scheduled to depart station 
platforms. 

Train Dispatcher 3 has separate windows for each of these categories and separate dialog displays for entering 
data.  To enter train data, select the “Train Schedule” menu item under the “Data” menu in the menu bar at the 
top of the screen.  The Train Data - General window shown in Figure 42 will appear. 
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Figure 42 - Train Data Window 
There is a different Train Data window for each of the four train data areas.  Figure 42 shows the data for the 
General data area.  To display data from another data area, click the “Passenger Sch”, the “Work Schedule” or 
the “Multiple Entries” button.  The first column of all displays contains the Train ID.  When the “Train Data – 
General” window is first called up, data is sorted by Train ID.  To sort the list by direction and the time the train is 
scheduled to enter the territory, click the “Sort by Time” button.  This and the “Sort by ID” button will operate on 
windows for all four train data areas. 

The user can re-size columns in each of these windows by placing the mouse on the vertical separators in the 
columns header and, while holding down the left mouse button, drag the mouse to the left or right.  Once the 
columns are re-sized, the user can save the column widths for the next time the window is displayed by clicking 
the “Save Column Widths” button. 

To add a new train, click the “New” button.  To delete or edit a train, first place the mouse pointer on any data in 
the train’s row in the window and single click the left button to select (highlight) the train.  Then click the “Delete” 
or “Edit” button.  The “Edit” button will cause the Train Data dialog to appear (see Figure 43). 

You can also place the mouse on data in a train’s row and click the right mouse button, which will cause a pop-
up menu to appear that has “New”, “Edit” and “Delete” menu items.  Double clicking the left mouse button on a 
train type row will automatically cause the Train Data dialog to appear in the edit mode. 

The train identifiers displayed in all four Train Data windows consist of the train identifier entered in the Train 
Data dialog in Figure 43 plus a dash (-) and then a unique train internal number.  Because several trains can 
have the same user entered identifier, it was necessary to add a unique number to the identifier to discriminate 
trains that have the same ID.  Train Dispatcher 3 will not display the unique train internal numbers in the Active 
Train List or on the Track Display. 

Information about the data displayed in each of the Train Data windows can be found in the following 
descriptions of each data area’s input dialog. 
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Figure 43 - Train Data - General Dialog 

9.3.1. Train Data - General Dialog 
The following describes each of the fields in the dialog: 

♦ Train ID - contains the train identifier.  The user can enter up to fifteen alpha/numeric characters into 
this field.  Several trains can have the same identifier. 

♦ Number - contains the unique train internal number.  The user cannot change this field. 

♦ Train Description - contains a description of the train.  The user can enter up to twenty alpha/numeric 
characters into this field.  Multiple trains can have the same description. 

♦ Train Direction - indicates the train’ s initial direction of movement on the screen. 

♦ Train Length - contains the train length in feet/meters.  The length must be greater than or equal to 50 
feet or 16 meters. 

♦ Train Type - indicates the type of train.  See Paragraph 9.2 for more information on train types. 

♦ Crew Time - the amount of time the crew has been on duty when it arrived on the territory. 

♦ Train enters at location - contains the entrance/exit location where the train will come onto the 
territory.  This field should be blank if the train was created from another train. 

♦ At time - contains the time the train will enter the territory.  This field should be blank if the train is 
already on the territory at the start of the simulation.  The time is entered in 24-hour military time.  To 
enter 1 AM type “100” or “0100”.  To enter 1 PM type “1300”. 

♦ Scheduled for - check boxes that indicate the days of the week the train will be scheduled to arrive on 
the territory. 

♦ Train is created from train - trains can be created from other trains.  To select a train identifier for this 
field click the down arrow to see a list of trains that could create this train.  Please note that you must 
have previously entered these trains into the system. 
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♦ Train exits at location -- contains the entrance/exit location where the train should exit the territory.  
This field should be blank if this train becomes (creates) a new train. 

♦ Train becomes a new train – trains can become new trains at a specified location.  This procedure is 
used often on a passenger system where the same physical equipment is assigned a new train identifier 
and runs on the schedule assigned to that identifier.  To select a train identifier for this field click the 
down arrow to see a list of trains this train could become.  Please note that you must have previously 
entered these trains into the system.  

♦ at location – the platform or area location (“P-“ for platform, “A-“ for area) where this train will become a 
new train and/or split into another train. 

♦ after XX minutes – the amount of time this train must be at the location before it becomes and/or splits 
into another train. 

♦ and splits into 2nd train – the train this train will split into.  To select a train identifier for this field click 
the down arrow to see a list of trains this train could split into.  Please note that you must have 
previously entered these trains into the system.  The split train will be located behind the original train in 
the block. The length of the original train will be reduced by the length of the split train.  

9.3.2. Train Data - Multiple Entries Dialog 
A train will often leave the territory and later return.  The best example of this is when a train leaves the territory 
to load coal at a mine and then returns to the territory to deliver that coal to its destination.  Train Dispatcher 3 
allows trains to reenter the territory up to ten times. 

To enter information on multiple entries, the user clicks the “Multiple Entries” tab in one of the Train Data dialogs 
(see Figure 43), which causes Figure 44 to appear. 

 

Figure 44 - Train Data - Multiple Entries Dialog 
The following describes the fields in the Train Data - Multiple Entries dialog. 

♦ Entrance -- contains the location where the train will return to the territory. 
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♦ Exit -- contains the location where the train should leave the territory after it re-entered the territory at 
the location specified in the “Entrance” field. 

♦ Delay -- contains the time in minutes from the time the train leaves the territory until it returns to the 
territory at the location specified in the “Entrance” field. 

♦ New ID -- contains the new train identifier for the train when it re-enters the territory at the location 
specified in the “Entrance” field.  If this field is blank, the last train identifier will be used. 

♦ New Entrance Direction – indicates whether the train re-enters the territory moving forward or in 
reverse. 

♦ New Type -- contains the new train type, if applicable.  For example, if a train left the territory empty and 
returned full the user may want the train to become a different type to reflect its change in weight.  If this 
field is blank, the last train type is used. 

♦ New Crew Time -- the train may have had a crew change when it was off the territory.  If there is an 
entry in this field, there was a crew change, and the time in minutes the new crew had been on duty 
when it arrived on the territory is entered into this field.  If this field is blank, there was not a crew change 
and the time the crew has been on duty is accumulated from the train’s last crew change. 

9.3.3. Train Data - Work Schedule Dialog 
A train will sometimes perform local work on the territory.  This local work often consists of local trains picking up 
and delivering cars to industrial customers along the mainline.  Train Dispatcher 3 allows a train to be scheduled 
for local work in up to ten locations on the territory. 

To enter information about local work, the user clicks the “Local Work Schedule” tab in one of the Train Data 
dialogs, which causes Figure 45 to appear. 

 

Figure 45 - Train Data - Work Schedule Dialog 
The following describes the fields in the Train Data – Work Schedule dialog. 

♦ Work Area -- contains the name of the track area where the local work will be performed. 



Train Dispatcher 3.5 

 Page 48  
14 November, 2003 

♦ Time in Area – is the time in minutes that the train will be stopped in the work area. 

♦ Direction Leaving Area – after the work is completed a train can leave the area and travel in either 
direction.  If it leaves the area in a direction that is opposite the direction from which it entered the area, 
the system assumes the train turned around in the area and will move forward (not reverse) in the new 
direction. 

9.3.4. Train Data - Passenger Schedule Dialog 
This function allows a user to define a train’s departure time for each platform defined in the territory.  To enter 
this information the user clicks the “Passenger Schedule” tab in one of the “Train Data” dialogs, and the Train 
Data – Passenger Schedule dialog will appear (see Figure 46). 

 

Figure 46 - Train Data - Passenger Schedule Dialog 
Each Train Data – Passenger Schedule dialog can display up to 10 station platform names.  If the territory has 
more that 10 platforms, there will be multiple Train Data – Passenger Schedule dialogs.  Each will have a tab 
such as “Passenger Schedule 1”, “Passenger Schedule 2”, etc. 

The following describes the fields in the Train Data -- Passenger Schedule dialog. 

♦ Platform name -- names of the platforms defined for the territory.  The user cannot add or delete 
platform names in this dialog.  To perform this function, select the “Station Platform Data” menu item 
under the “Data” menu in the menu bar. 

♦ Scheduled Departure -- contains the time the train is scheduled to depart the passenger station or 
platform.  The time is entered in 24-hour military time.  To enter 1 AM, type “100” or “0100”.  To enter 1 
PM, type “1300”. 

♦ Dwell Time -- contains the amount of time in seconds the train will stay at the station to load and unload 
passengers.  The first train in Figure 46 will depart, for example, 60 seconds after it arrived if it is behind 
schedule.  If it is running ahead of schedule, it will depart at the scheduled departure time. 

♦ Add XXX minutes to departures -- since adding passenger schedules is a long and tedious process, 
we added this feature to simplify the schedule entry for subsequent or earlier trains that run on 
schedules similar to trains already entered.  To add or subtract time from a train schedule enter the time 
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in minutes (negative minutes to subtract time) and click the “Add“ button.  All departure times in the 
Train Data – Passenger Schedule dialog will be immediately updated. 

9.4. Simulation Start Times 
When a simulation is started the user can specify a number of start times.  The user can view information about 
start times. 

To view the start time data select the “Start Time” menu item under the “Data” menu in the menu bar at the top 
of the screen.  The Start Times window in Figure 47 will appear. 

 

Figure 47 - Start Times Window 
This window displays information about all of the start times.  To re-size any column in this window place the 
mouse on a vertical separator in the columns header and, while holding down the left mouse button, drag the 
mouse to the left or right.  Once the columns are re-sized, the user can save the column widths for the next time 
the window is displayed by clicking the “Save Column Widths” button. 

To view data on a start time, first place the mouse pointer on the data in the start time’s row and single click the 
left mouse to select (highlight) the start time.  Then click the “View” button.  The “View” button will cause the 
Start Time Data dialog to appear (see Figure 48). 

Double clicking the left mouse button on data in a start time’s row will automatically cause the Start Time Data 
dialog to appear. 
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Figure 48 - Start Time Data Dialog 
The following describes each of the fields in the dialog: 

♦ Train location at start time – this is a list of trains that are on the territory at the start time.  Included in 
this list, form left to right, is the following data about each train; 

o Train Identifier 

o Block in which the train is located at the start of the simulation 

o Direction the train is moving at the start of the simulation 

o Time (in minutes) the crew has been on duty at the start of the simulation 

o The first work area the train will see after the start of the simulation 

o The number of multiple entries the train has made at the start of the simulation 

Trains in this list are sorted by their Train Identifier. 

♦ Start time - is the time of the day the simulation will start. 

♦ Scheduled for - is a group of check boxes that indicate for which days of the week the start time is 
valid.   A single start time entry can be used for every day of the week. 

♦ No end time - Train Dispatcher 3 can run the simulation for multiple days up to 90.  If this box is 
checked, Train Dispatcher 3 will not end the simulation until 90 days after the start. 

♦ End time - the time the simulation will end. 

♦ after xx days - is the number of days (or 24 hour periods) the simulation will run.  If this number is 0, 
the start time is 00:01, and the end time is 23:59, the simulation will start at 00:01 on the first day and 
end at 23:59 on the first day.  If the number of days is 1, the simulation will start at 00:01 on the first day 
and end at 23:59 on the second day. 

♦ Train – is the train identifier of the selected train in the “Train location at start time” list 

♦ Start block – is the block where the selected train will be located when the simulation starts 

♦ Crew time – is the time the crew has been on duty for the selected train at the start of the simulation. 
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♦ Start direction – is the direction in which the selected train is traveling at the start of the simulation. 

♦ Start at work area – is the number of the next work area in which the selected train is scheduled to 
perform work.  If the train has not performed work at any of the scheduled areas at the start of the 
simulation, this number will be 1.  If it has already completed work at the first work area, this number will 
be 2. 

♦ Start at multiple entry – is the number of multiple entries the train has completed prior to the start of 
the simulation.  If the train has never left the territory this number will be 0.  If the train has left the 
territory once and returned, this number will be 1. 

9.5. Entrance/Exit Locations 
Each entrance/exit location has information regarding its entrance priority, whether or not it is a yard entrance, 
whether or not the yard has a capacity limitation, and whether or not the train has to ask the dispatcher for 
permission to enter the territory at the location. 

The user can view information about each entrance/exit location by selecting the “Entrance/Exit Location” menu 
item under the “Data” menu in the menu bar at the top of the screen.  The Entrance/Exit Location Window in 
Figure 49 will appear. 

 

Figure 49 - Entrance/Exit Location Window 
This window displays information about all entrance/exit locations.  To re-size any of the columns in this window, 
place the mouse on a vertical separator in the columns header, and, while holding down the left mouse button, 
drag the mouse to the left or right.  Once the columns are re-sized, the user can save the column widths for the 
next time the window is displayed by clicking the “Save Column Widths” button. 

The following describes each of the columns in this window: 

♦ Name - name of the entrance/exit location 

♦ Block - the block number that is associated with this entrance/exit location. 

♦ Direction - the side of the block the entrance/exit location is on 

♦ Priority (0-9) 0 is highest, 9 is lowest - the same entrance/exit name can be assigned to several block 
locations.  Train Dispatcher 3 will check each of the blocks to see if the train can enter at that block.  If 
the block is occupied or cleared in the opposite direction, Train Dispatcher 3 will check the other blocks 
assigned as entrance/exit locations. 

Priorities are assigned from 0 to 9.  0 is the highest priority, and 9 indicates the train will never try to 
enter the territory at that location. 

♦ Yard Entrance – indicates if this entrance/exit location is associated with a yard. 
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♦ 24 Hour Capacity – if it is a yard entrance, this field indicates the number of trains per day the yard can 
handle.  If Train Dispatcher 3 sees this capacity being exceeded, it will prevent trains from exiting into 
the yard until the number of trains handled over a given period of time is reduced below the yard’s 
capacity. 

♦ Permission To Enter – indicates if trains entering the territory at this entrance/exit location are required 
to ask permission before entering the territory. 

9.6. Block Permits 
The user can create and modify block permits (Track and Time) and specify when they become active.  The 
user can enter information about block permits by selecting the “Block Permits” item under the “Data” menu in 
the menu bar at the top of the screen.  The Block Permits window in Figure 50 will appear. 

 

Figure 50 - Block Permits Window 
This window displays information about all block permits.  To re-size any of the columns in this window, place 
the mouse on a vertical separator in the columns header, and, while holding down the left mouse button, drag 
the mouse to the left or right.  Once the columns are re-sized, the user can save the column widths for the next 
time the window is displayed by clicking the “Save Column Widths” button. 

This window can be sorted by the block permits’ track names or the requested times for the block permits to 
start by clicking the “Sort Track” or “Sort Time” buttons. 

To add a new block permit click the “New” button.  To delete or edit a block permit, first place the mouse pointer 
on its data and single click the left mouse button to select (highlight) the block permit.  Then click the “Delete” or 
“Edit” button.  The “Edit” button will cause the Block Permit dialog to appear (see Figure 51). 

You can also place the mouse on data in a block permit’s row and click the right mouse button, which will cause 
a pop-up menu having “New”, “Edit” and “Delete” menu items to appear.  Double clicking the left mouse button 
on data in a block permit’s row will automatically cause the Block Permit dialog to appear in the edit mode. 



Train Dispatcher 3.5 

 Page 53  
14 November, 2003 

 

Figure 51 - Block Permit Dialog 
The following describes each of the fields in the dialog: 

♦ Number – is the internal number, which cannot be changed by the user, that the system has assigned 
to the block permit.  

♦ From time -- contains the requested start time of the block permit.  The time is entered in 24-hour 
military time.  For example, 1 AM would be entered as “0100” and 1 PM as “1300. 

♦ To time -- contains the requested end time of the block permit.  The time is entered in 24-hour military 
time. For example, 1 AM would be entered as “0100” and 1 PM as “1300”.  

♦ Scheduled for – is a group of check boxes that indicate the days of the week the block permit will be 
active. 

♦ Track name – is the name of the track (a group of blocks) protected by the block permit.  To display a 
list of allowable track names, click the down arrow at the right side of the selection box. 

♦ Requestor name – is a text entry field that holds the name of the person requesting the block permit. 

♦ Reason – is a text entry field that holds the reason for the block permit request. 

9.7. Slow Orders 
The user can create or modify temporary or permanent slow orders, designate when they become active, and 
specify their speed restrictions for the different train types.  The user can enter information about slow orders by 
selecting the “Slow Order” item under the “Data” menu in the menu bar at the top of the screen.  The Slow Order 
window shown in Figure 52 will appear. 

 

Figure 52 - Slow Orders Window 
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This window displays information about all of the slow orders.  To re-size any of the columns in this window, 
place the mouse on a vertical separator in the columns header, and, while holding down the left mouse button, 
drag the mouse to the left or right.  Once the columns are re-sized, the user can save the column widths for the 
next time the window is displayed by clicking the “Save Column Widths” button. 

This window can be sorted by the slow orders’ track/block/switch names or the slow order start times by clicking 
the “Sort Track” or “Sort Time” buttons. 

To add a new slow order, click the “New” button.  To delete or edit a slow order, first place the mouse pointer on 
its data and single click the left mouse button to select (highlight) the slow order.  Then click the “Delete” or 
“Edit” button.  The “Edit” button will cause the Slow Order Data dialog to appear (see Figure 53). 

You can also place the mouse on data in a slow order’s row and click the right mouse button, which will cause a 
pop-up menu having “New”, “Edit” and “Delete” menu items to appear.  Double clicking the left mouse button on 
data in a slow order’s row will automatically cause the Slow Order Data dialog to appear in the edit mode. 

 

Figure 53 - Slow Order Data Dialog 
The following describes each of the fields in the dialog: 

♦ Number – is an internal number, which cannot be changed by the user, given to the slow order by the 
system, 

♦ Track/block/switch name – is the name of the track (a group of blocks), block or switch that is affected 
by the slow order.  To display a list of allowable track, block and switch names, click the down arrow at 
the right side of the selection box. 

♦ Permanent – is a check box that, if checked, indicates that the slow order is always in affect. 

♦ From time -- contains the start time of the slow order.  The time is entered in 24-hour military time.  For 
example, 1 AM would be entered as “0100” and 1 PM as “1300. 

♦ To time -- contains the end time of the slow order.  The time is entered in 24-hour military time. For 
example, 1 AM would be entered as “0100” and 1 PM as “1300”.  

♦ Scheduled for – is a group of check boxes that indicate the days of the week the slow order is in affect. 

♦ SLOW ORDER SPEEDS -- the maximum speed a train will be allowed to move over the track section, 
block or switch during the slow order.  Maximum speeds are set for each train type in each direction. 
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If there is no speed in this field for a type of train in a specified direction, the speed of the train over the 
track section, block or switch during the slow order will not vary from its normal speed over the track 
section, block or switch. 

9.8. Wayside Detectors 
Up to ten types of wayside detectors can be specified for a territory.  Wayside detectors are used to monitor 
passing trains for various types of problems.  Two of the most common types of wayside detectors are hot box 
(journal) and dragging equipment. 

To view information about wayside detectors, select the “Wayside Detectors” item under the “Data” menu in the 
menu bar at the top of the screen.  The Wayside Detector Data window shown in Figure 54 will appear. 

 

 Figure 54 - Wayside Detector Data Window 
This window displays information about all wayside detectors.  To re-size any of the columns in this window, 
place the mouse on a vertical separator in the columns header, and, while holding down the left mouse button, 
drag the mouse to the left or right.  Once the columns are re-sized, the user can save the column widths for the 
next time the window is displayed by clicking the “Save Column Widths” button. 

The following describes each of the columns in this window: 

♦ Description – is the name or description of the wayside detector. 

♦ Generate a Warning – indicates if the alarm will create a warning that will stop the train.  Hot boxes, for 
example, create false alarms.  If this field contains a “Yes”, the train will stop for the crew to check the 
train (Warning Delay).  If the crew finds a problem, there will be an additional delay (“Problem Delay” 
field) for the time it will take the crew to correct the problem.  In the case of a real hot box the crew 
would remove the car from the train. 

♦ Warning Delay – is the time in minutes for the crew to check the train for a problem. 

♦ Problem Delay – is the time in minutes for the crew to correct the problem. 

9.9. OS Names 
Train Dispatcher 3 can create a train graph showing the movement of trains during a simulation.  The train 
graph shows when a train arrives at each of the OS points (OS is sometimes referred to as on-station or out of 
station). 

To view information about OS point select the “OS Points” item under the “Data” menu in the menu bar at the 
top of the screen.  Figure 55 will then appear. 
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Figure 55 - OS Data Window 
This window displays information about all OS points.  The user can re-size any of the columns in this window 
by placing the mouse on a vertical separator in the columns header, and, while holding down the left mouse 
button, drag the mouse to the left or right.  Once the columns are re-sized, the user can save the column widths 
for the next time the window is displayed by clicking the “Save Column Widths” button. 

The window lists the blocks and switches that are assigned to each OS point.  An unlimited number of blocks or 
switches can be assigned to each OS point, but only 10 will be displayed. 

10. FINDING A TRAIN, TRACK, BLOCK, SWITCH, DIAMOND OR SIGNAL 
Train Dispatcher 3 has a tool to help users find a particular train, track, block, switch, diamond or signal.  To find 
one of these items, select the appropriate menu item under the “Find” menu.  If the “Find a Train” menu item is 
selected, the dialog illustrated by Figure 56 will appear. 

 

Figure 56 - Find a Train Dialog 
To locate a particular train, place the mouse pointer on its ID, and click to left mouse button.  This will cause this 
dialog to disappear and the mouse pointer to be placed on the selected item in the Track Display. 

Other track elements can be found in the same way by choosing the appropriate item under the “Find” menu. 
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11. CTC CONTROL MODE 
Train Dispatcher 3 can operate as a CTC office for a model railroad signaling system.  It has the capability to 
send switch and signal commands and to receive signal indications, switch positions, and block occupancy 
status. 
 
Train Dispatcher 3 does not communicate directly with external hardware.  Since there are many types of 
hardware interfaces, Train Dispatcher 3 relies on programs commonly called handlers that are specifically 
written to communicate with a particular piece of external hardware.  These allow Train Dispatcher 3 to have 
one common interface for many types of external equipment.  It also allows users to develop their own handlers 
for new types of equipment. 
 
Even though Train Dispatcher 3 is capable of operating as a CTC office for a commercial railroad, Train 
Dispatcher 3 customers are not licensed to use Train Dispatcher 3 in any commercial application.  Use of Train 
Dispatcher 3 in commercial applications is strictly prohibited.  If you are interested in using Train Dispatcher 3 in 
a commercial application, please contact Signal Computer Consultants at 888 872-4612 or 412 655-1884. 
 
CTC Control Mode is a free upgrade to Train Dispatcher 3 customers.  Because it is a free upgrade we do not 
provide free support for the CTC Control Mode function.  A support contract is available.  For more information 
about a support contract for the CTC Control Mode function, contact Signal Computer Consultants at 888 872-
4612 or 412 655-1884. 
 

11.1. Handler Communication 
Train Dispatcher 3 communicates with equipment handlers by writing to and reading messages from two 
comma delimited text files.  Although this is not a very elegant means of communication between two programs, 
it is very simple and extremely easy to troubleshoot.  Normally these two files reside in the same folder as the 
Train Dispatcher 3 program (Train3.exe), but can be assigned to another folder or disk (RAM disk) by clicking on 
the Options/Assign CTC File Folder menu item. 
 
Any word processing program such as Notepad, WordPad or Word can view these text files. 
 
The text file that is used to send commands from Train Dispatcher 3 to the handler is called 
td3ctccommands.txt.  The text file into which Train Dispatcher 3 receives status indications from the handler is 
called td3ctcindications.txt. 
 
Each of the files is a comma delimited text file with each record (message) in the file terminated with a line feed 
character (Hex 0A).  Records have variable lengths. 
 
Train Dispatcher 3 will only write records to the td3ctccommands.txt file when Train Dispatcher 3 is placed in 
CTC mode (select the CTC Mode menu item under the Mode menu). 
 

11.2. CTC Control Mode Functions 
When Train Dispatcher 3 is placed in CTC Control mode, the simulation clock will show the time of day.  Most of 
the Train Dispatcher 3 simulation functions will be disabled.  Signal and switch commands will also act 
differently. 
 
When switches are thrown, instead of the switch automatically moving to the new position, Train Dispatcher 3 
will blink the switch and send a command to the handler to throw the switch.  Train Dispatcher 3 accomplishes 
this by adding a switch command record to the td3ctccommands file.  The switch will continue to blink until a 
switch status message is received from the handler that indicates that the switch has been moved to the 
requested position.  Any time before the switch status message is received, the user can cancel the switch 
request by placing the mouse on the switch and clicking the left mouse button. 
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Train Dispatcher 3 will constantly try to read the td3ctcindications.txt file.  When it sees that this file exists, it will 
rename the file and begin processing the status records in the file.  Once Train Dispatcher 3 renames the file, 
the td3indications.txt file will no longer exist in the system.  When the handler wants to add a new status record, 
it will create a new td3ctcindications.txt file if it does not exist or append the new record to the end of an existing 
td3ctcindications.txt file. 
 
Signals will also no longer automatically clear a route when they are clicked.  Train Dispatcher 3 will blink the 
signal and the route until it receives a status message from the handler that the route has been cleared.  As with 
switches, a request to clear a signal can be cancelled prior to receiving a command from the field that the signal 
has been cleared. 
 

11.3. CTC Control Log File 
To help troubleshoot, a log file called td3ctclog.txt can be maintained.  This file contains all records that were 
sent to and received from the handler and can be viewed by any word processing program. 
 
The log file function is turned on/off from a check box located in the Assign CTC File Folder dialog that is 
displayed by clicking on the Options/Assign CTC File Folder menu item. 
 
Train Dispatcher 3 will monitor the size of this file.  When it reaches 1,000,000 bytes Train Dispatcher 3 will 
reduce its size to 800,000 bytes by deleting the oldest records. 
 
To view the CTC Log file, select the View/Show CTC Control Log File menu item. 
 

11.4. Train Tracking 
When Train Dispatcher 3 receives a block status message indicating that a block previously unoccupied is now 
occupied, it will search the adjacent blocks for the train cleared into the blocks.  If it finds the train, it will display 
the train identifier on the new occupancy block and move the train icon to it (if in graphic display mode).  Please 
note that the train found in the adjacent block must have a clear signal into the newly occupied block. 
 
If a train is not found, it will create a new train and assign it an identifier.  The format for the identifier will be 
Tdxxxx where d is the day of the week (0 for Sunday, 1 for Monday, etc.) and xxxx is the train number.  The 
train number starts at 0000 at the beginning of the simulation and increments by one each time a new train is 
created.  The direction a new train will face is left unless traffic direction information was included in the block 
status message sent by the handler. 
 
When Train Dispatcher 3 receives a block status message that a block previously occupied is now unoccupied, 
it will remove the train identifier from the block.  If the train is not occupying another block, Train Dispatcher 3 
will assume the train has left the territory. 
 
Please note that the train tracking algorithms are not extremely sophisticated.  If, for example, a train spans 
several track blocks, and one of the blocks in the center of the train becomes unoccupied, Train Dispatcher 3 
will split the train in two and assign a new train identifier to the back half of the original train. 
 

11.5. Train Parameters and Commands 
The user can modify the parameters of a tracked train and issue commands to the train.  To access these 
functions place the mouse pointer on the train and click the right mouse button.  A pop-up menu will appear. 
 
Clicking on the Train "XXXX" Reverse Direction menu item will cause the train to point in the opposite direction. 
 
Clicking on the Train "XXXX" Properties menu item will cause the Train Information dialog to appear.  You can 
change all of the train's parameters in this dialog (see Figure 57). 
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Figure 57 - Train Information 

 
Clicking on the Train "XXXX" Status menu item will cause the CTC Active Train List window to appear with the 
selected train highlighted.  By clicking the Properties button in this window, the Train Information dialog will 
appear for the train (see Figure 58). 
 

 
Figure 58 - CTC Active Train List 

 
The CTC Active Train List window can also be accessed by clicking the Trains menu item near the top of the 
screen.   Select the appropriate train (place the mouse on the train and click the left mouse button), and then 
click the Properties button to display the Train Information dialog for the train. 
 
If another train is located in an adjacent block, clicking the Train "XXXX" Merge Ahead with Train "XXXX" menu 
item or Train "XXXX" Merge Behind with Train "XXXX" will cause the two trains to merge into one. 
 
There may be times when a train needs to have the block ahead cleared, but there is no controlled signal at the 
block entrance.  The Train "XXXX" Clear Blocks Ahead menu item is available in CTC Control Mode and will 
clear all of the blocks ahead of the train to the next controlled signal.  
 
Train Dispatcher 3 maintains OS information.  The OS time is the current time on the clock. 
 
Train OS data can be displayed by placing the mouse pointer on the train and clicking the right mouse button.  A 
pop-up menu will appear.  Select the Train "XXXX" OS menu item to bring up the Train OS Report window. 
 
The train graph function is also active in CTC mode and will show OS data for all trains.  To display the train 
graph, select the View/Display Train Graph menu item. 
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11.6. Speed Control 
For model railroad operation it is helpful to provide speed information to the external hardware.  With this 
information, a model railroad can control train separation between following trains and slow a train up when it 
must stop at the next signal. 
 
When a signal is cleared, Train Dispatcher 3 will send to the handler a message for each block that is in the 
cleared path.  This message will show the block status (cleared), the cleared direction (traffic direction) and the 
number of blocks beyond this block that have a cleared signal.  If the next block is occupied, the number will be 
zero. 
 
The number of blocks cleared ahead will never be reported as a number higher that two.  If four blocks are 
actually cleared ahead, this message will only indicate two. 
 
This message will be sent again any time the status of the block changes or the number of blocks cleared ahead 
changes. 
 
Train Dispatcher 3 does not expect the handler to respond to these messages.  If speed information is of no 
interest to the handler, these messages can be ignored. 
 

11.7. Train ID Reporting 
Any time Train Dispatcher 3 sees that a block status has changed from unoccupied to occupied or that a train's 
identifier or type has changed, it will send a message to the handler for each affected block, which contains the 
train identifier of the train occupying the block and its type. 
 
Train Dispatcher 3 does not expect the handler to respond to these messages.  If the train identifier or type 
information is not of interest, these messages can be ignored. 
 

11.8. Block Permits (T & T) 
Block permits can be issued in CTC Control Mode.  There are two methods for issuing block permits.  The first 
is to click on the Permits menu near the top of the screen.  This will cause the CTC Active Block Permit List 
window to appear (see Figure 59).  Click on the Issue button to create a new block permit (see Figure 60). 
 

 
Figure 59 - CTC Active Block Permit (T&T) List 

 
The second method is to place the mouse pointer on the track for which you want to issue the block permit and 
click the right mouse button.  This will cause a pop-up menu to appear.  Select the Issue Block Permit menu 
item to create a new permit. 
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Figure 60 - CTC Block Permit Dialog 

 

11.9. Test Handler 
Included with Train Dispatcher 3 is a Test Handler program called testhandler.exe.  This program, when 
running, will automatically respond to signal and switch commands sent by Train Dispatcher 3.  It will also send 
user-generated messages to Train Dispatcher 3 in the proper format. 
 
When the program is first executed, a Test File Folder Setup dialog will appear.   The first parameter in this 
dialog specifies the folder name where the td3ctccommands.txt file can be found.  This is the folder in which the 
Test Handler program will create the td3ctcindications.txt file.  This folder should be the same as specified in the 
Train Dispatcher 3 Assign CTC File Folder dialog. 
 
The second parameter in the Test File Folder Setup dialog specifies, in seconds, how often the Test Handler 
program will execute.  If the Test Handler program sees a message in the td3ctccommands.txt file, it will not 
respond to that message until it runs a second time.   
 
The Test File Folder Setup dialog can be displayed at any time by clicking on the Setup menu at the top of the 
screen. 
 
Manually generated messages can also be sent to Train Dispatcher 3 at any time.  Manually generated 
messages are entered into a text file with the following format: 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Device 
Type 

SIGNAL 
SWITCH 
BLOCK 

The type of record. 

2 Device 
Name 

Alpha/Numeric Each signal, switch and block when created by Track 
Builder 3, can be assigned a unique remote monitor 
name that identifies the signal to the external 
program.  If a remote monitor name was not 
assigned, Train Dispatcher 3 will recognize a name 
that uses its internal number.  The format is 
SIGNALXXXX, SWITCHXXXX, or BLOCKXXXX 
where XXXX is the number. 

3 Status STOP 
CLEAR 
NORMAL 
REVERSE 

The status of the device. 
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UNOCCUPIED 
OCCUPIED 
OCCUPIEDLEFT 
OCCUPIEDRIGHT

 
Examples: 
BLOCK,BLOCK0004,OCCUPIED 
SWITCH, SWITCH0102,NORMAL 
 
The Test Handler program reads the records in this file and creates a corresponding status message that it 
sends to Train Dispatcher 3 in the td3ctctindications file. 
 
To send a manually generated message, click on the Send File menu at the top the screen.  This will cause the 
Send File dialog to appear.  Enter the file path and name and click the Ok button to send. 
 
 

11.10. Command Records 
Train Dispatcher 3 generates command records when it wants the external hardware to perform a specific 
action like throwing a switch or clearing a signal.  Block commands are also sent.  Block commands provide 
speed control information to the handler if the block is cleared or train identifier information if the block is 
occupied. 
 
There is also a command that requests the handler to send all the block occupancy status and switch position 
messages.  This command is used when Train Dispatcher 3 is first started so that it can synchronize with the 
hardware. 
 
Command records contain a series of fields separated by commas.  The first field in the record always defines 
the type of record and the second always contains the sequence number.  
 
The sequence number is a 4-digit number.   Each time Train Dispatcher 3 generates a new record it increments 
the sequence number by one.  When the sequence number reaches 10000, it is reset to zero.  
 
Command records are not case dependent.  “CONTROL” is the same as “control”. 
 
Leading zeroes are not necessary.  “09:01:01” is interpreted the same as “9:1:1” by Train Dispatcher 3. 
 
There are six types of command records.  The following table lists these types: 
 
Type Field Code Description 
Control CONTROL Requests the handler to perform a specific control command not related to 

switch, signal or block commands.   
Time TIME Contains the Train Dispatcher 3's time when requested by a command 

issued by the handler 
Signal SIGNAL Requests a specific signal command 
Switch SWITCH Requests a specific switch to change its position 
Block BLOCK Provides speed control or train identifier information 
Error ERR Contains error information about a bad message received by Train 

Dispatcher 3 in the td3ctcindications.txt 
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The following six tables describe the fields in each type of command record.  An example follows each table. 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

ALLDATA Requests the handler to send all switch positions and 
block occupancy status records. 

4 Time HH:MM:SS The time Train Dispatcher 3 issued this command.  
The first two characters are the hours, the next two 
the minutes, and the final two the seconds. 

 
Example: 
CONTROL,0034,ALLDATA,14:33:19 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type TIME The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Time HH:MM:SS The current time.  The first two characters indicate 
the hour followed by the minutes and seconds on the 
Train Dispatcher 3 clock. 

 
Example: 
TIME,0034,15:11:12 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type SIGNAL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Signal 
Name 

Alpha/Numeric Each signal, when created by Track Builder 3, can be 
assigned a unique remote monitor name that identifies 
the signal to the external program.  If a remote 
monitor name was not assigned, Train Dispatcher 3 
will recognize a name that uses its internal signal 
number.  The format is SIGNALXXXX, where XXXX is 
the signal number. 

4 Time HH:MM:SS The time the Train Dispatcher 3 issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

5 Signal 
Command 

CANCEL 
CLEAR 
 

The signal command being issued.  Commands can 
be issued for canceling a signal or clearing a signal. 

6 Free 
Blocks 

Numeric 0 to 2 This field will only exist if the status of the signal is 
CLEAR.  This field contains the number of blocks 
ahead of this signal that are also cleared in the same 
direction.  If the number is greater than 2, 2 will be 
contained in this field. 

 
Example: 
SIGNAL,0112,SIGNAL0122,11:15:10,CLEAR,1 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type SWITCH The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Switch 
Name 

Alpha/Numeric Each switch, created by Track Builder 3, can be 
assigned a unique remote monitor name that identifies 
the switch to the external program.  If a remote 
monitor name was not assigned, Train Dispatcher 3 
will recognize a name that uses its internal switch 
number.  The format is SWITCHXXXX, where XXXX 
is the switch number. 

4 Time HH:MM:SS The time Train Dispatcher 3 issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

5 Switch 
Command 

NORMAL 
REVERSE 

The switch position command being issued.  
Commands can be issued for throwing the switch into 
the normal or reverse position. 

 
Example: 
SWITCH,0187,SWITCH0005,08:32:19,NORMAL 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type BLOCK The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Block 
Name 

Alpha/Numeric Each block, when created by Track Builder 3, can be 
assigned a unique remote monitor name that 
identifies the block to the external program.  If a 
remote monitor name was not assigned, Train 
Dispatcher 3 generates one.  The generated name 
will be BLOCKXXXX, where XXXX is the block 
number. 

4 Status CLEAREDLEFT 
CLEAREDRIGHT 
OCUPIEDLEFT 
OCCUPIEDRIGHT
UNOCCUPIED 
 

The status code of the block.  The status code is 
composed of the cleared, occupied or unoccupied 
status of the block followed by the traffic direction 
when the block is cleared or occupied. 
 

5 Time HH:MM:SS The time Train Dispatcher 3 issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

6 Train ID Alpha/Numeric This field will only exist if the status of the block is 
OCCUPIEDLEFT or OCCUPIEDRIGHT.  This field 
contains the train identifier of the first train traveling 
in the direction of the traffic. 

6 Free 
Blocks 

Numeric 0 to 2 This field will only exist if the status of the block is 
CLEAREDLEFT or CLEAREDRIGHT.  This field 
contains the number of blocks ahead of this block 
that are also cleared in the same direction.  If the 
number is greater than 2, 2 will be contained in this 
field. 

7 Train Type Alpha/Numeric This field will only exist if the status of the block is 
OCCUPIEDLEFT or OCCUPIEDRIGHT.  This field 
contains the train type of the first train traveling in the 
direction of the traffic. 

 
Example: 
BLOCK,0005,BLOCK0020,OCCUPIEDRIGHT,13:12:59,Train2,Passenger 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type ERR The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Error 
message 

Alpha/Numeric A text error message, in quotes, that explains the 
problem with the command record. 

4 Command 
Record 

Alpha/Numeric The command record, in quotes, with which this error 
message is associated. 

 
Example: 
ERR,0008,"The signal named in the third field of the message could not be found on 
the track layout", "SIGNAL,0011,SIGNAL0412,12:23:17, CLEAR" 

 
 

11.11. Status Indication Records 
The handler generates status records when the status of a block, signal or switch changes or when Train 
Dispatcher 3 requests that all status information be sent. 
 
Status records contain a series of fields separated by commas.  The first field in the record always defines the 
type of record and the second always contains the sequence number.  
 
The sequence number is a 4-digit number.   Each time the handler generates a new record it increments the 
sequence number by one.  When the sequence number reaches 10000, it is reset to zero.  
 
There are four types of status indication records.  The following table lists these types: 
 
Type Field Code Description 
Control CONTROL Requests Train Dispatcher 3 to perform a specific control command.   
Signal SIGNAL Contains the current signal status 
Switch SWITCH Contains the current switch status 
Block BLOCK Contains the current block status 

 
Each of the following tables describes the fields in each status indication record type and is followed by an 
example: 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

TIME Requests Train Dispatcher 3 to send its current time 
(TIME command record). 

4 Time HH:MM:SS The time the handler generated this message.  The 
first two characters are the hours followed by the 
minutes and seconds 

 
Example: 
CONTROL,0023,TIME,15:46:09 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type SIGNAL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Signal 
Name 

Alpha/Numeric Each signal, when created by Track Builder 3, can 
be assigned a unique remote monitor name that 
identifies the signal to the external program.  If a 
remote monitor name was not assigned, Train 
Dispatcher 3 generates one.  The generated name 
will be SIGNALXXXX, where XXXX is the internal 
signal number. 

4 Status CLEAR 
STOP 
 

The status code of the signal. 
 

5 Time HH:MM:SS The time the handler generated this message.  
The first two characters are the hours followed by 
the minutes and seconds. 

 
Example: 
SIGNAL,0006,SIGNAL0019,CLEAR,09:23:17 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type SWITCH The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Switch 
Name 

Alpha/Numeric Each switch, when created by Track Builder 3, can 
be assigned a unique remote monitor name that 
identifies the switch to the external program.  If a 
remote monitor name was not assigned, Train 
Dispatcher 3 generates one.  The generated name 
will be SWITCHXXXX, where XXXX is the internal 
switch number. 

4 Position NORMAL 
REVERSE 
 

The position code of the switch.  The position code 
indicates whether the switch is in the normal or 
reverse position.  

5 Time HH:MM:SS The time the handler generated this message.  The 
first two characters are the hours followed by the 
minutes and seconds 

6 Status OCCUPIED 
OCCUPIEDRIGHT
OCCUPIEDLEFT 
UNOCCUPIED 

The status code of the switch.  The status code is 
composed of the switch occupied or unoccupied 
status followed by the traffic direction (if the direction 
is available).  This is an optional field and does not 
have to be included in the message. 

 
Example: 
SWITCH,0056,SWITCH0199,NORMAL,17:12:54,OCCUPIEDLEFT 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type BLOCK The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Block 
Name 

Alpha/Numeric Each block, when created by Track Builder 3, can be 
assigned a unique remote monitor name that 
identifies the block to the external program.  If a 
remote monitor name was not assigned, Train 
Dispatcher 3 generates one.  The generated name 
will be BLOCKXXXX, where XXXX is the internal 
block number. 

4 Status OCCUPIED 
OCUPIEDLEFT 
OCCUPIEDRIGHT
UNOCCUPIED 
 

The status code of the block.  The status code is 
composed of the block occupied or unoccupied 
status followed by the traffic direction (if available) 
when the block is occupied. 
 

5 Time HH:MM:SS The time the handler generated this message.  The 
first two characters are the hours followed by the 
minutes and seconds 

 
Example: 
BLOCK,0005,BLOCK0020,OCCUPIEDRIGHT,13:12:59 
 

12. EXTERNAL I/O INTERFACE 
 
Train Dispatcher 3 allows an external program to control and monitor train dispatcher functions.  Commands 
and status indications are transferred from and to an external program via text files that by default reside in the 
same folder as the Train Dispatcher 3 program (Train3.exe).  However, clicking on the Options/Assign External 
I/O File Folder menu item can change the folder in which these files reside. 
 
Any word processing program such as Notepad, WordPad or Word can view these text files. 
 
The text file that is used to send commands to Train Dispatcher 3 from an external program is called 
td3commands.txt.  The text file that Train Dispatcher 3 uses to transfer status indications to an external program 
is called td3indications.txt. 
 
Each of the files is a comma delimited text file with each record in the file terminated with a line feed character 
(Hex 0A).  Records have variable lengths. 
 
Train Dispatcher 3 will only write records to the td3indications.txt file when Train Dispatcher 3 is placed in 
External I/O mode (select the External I/O menu item under the Mode menu) and after a Start Time and Day 
have been selected (click the Start button after the territory is loaded). 
 
When a switch, signal or block status changes, Train Dispatcher 3 will append a new record to the end of the 
td3indications.txt file.  If the file does not exist, Train Dispatcher 3 will create a new td3indications.txt file. 
 
When in External I/O mode, Train Dispatcher 3 will monitor the td3commands.txt file.  When it sees that this file 
exists, it will rename the file and begin processing the command records in the file.  Once Train Dispatcher 3 
renames the file, the td3commands.txt file will no longer exist in the system.  When the external program wants 
to add a new command record, it will have to create a new td3commands.txt file. 
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12.1. External I/O Log File 
To help troubleshoot, a log file called td3eiolog.txt can be maintained.  This file contains all records that were 
sent to and received from the external program and can be viewed by any word processing program. 
 
The log file function is turned on/off from a check box located in the Assign External I/O File Folder Name dialog 
that is displayed by clicking on the Options/Assign External I/O File Folder menu item. 
 
Train Dispatcher 3 will monitor the size of this file.  When it reaches 1,000,000 bytes Train Dispatcher 3 will 
reduce it to 800,000 bytes by deleting the oldest records. 
 
To view the External I/O Log File select the View/Show External I/O Control Log File menu item. 
 

12.2. Command Records 
The external program generates command records when the program wants Train Dispatcher 3 to perform a 
specific action like throw a switch or clear a signal.  There are also commands to load a new simulation, start or 
stop (pause) the simulation, request the current simulation time, and request the current status of all blocks, 
signals, and switches. 
 
Command records contain a series of fields separated by commas.  The first field in the record always defines 
the type of record and the second always contains the sequence number.  
 
The sequence number is a 4-digit number.   Each time the external program generates a new record, the 
sequence number is incremented by one.  When the sequence number reaches 10000, it is reset to zero.  
 
Command records are not case dependent.  “CONTROL” is the same as “control”. 
 
Leading zeroes are not necessary.  “09:01:01” is interpreted the same as “9:1:1” by Train Dispatcher 3. 
 
There are three types of command records.  The following table lists these types: 
 
Type Field Code Description 
Control CONTROL Requests Train Dispatcher 3 to perform a specific control command not 

related to switch and signal commands.  These control commands are for 
things such as loading a new simulation and starting or stopping the 
simulation clock. 

Signal SIGNAL Requests a specific signal command 
Switch SWITCH Requests a specific switch to change its position 
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Each of the following tables describes the fields in various command records and is followed by an example: 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

LOAD Request Train Dispatcher 3 to load a track territory. 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

5 File Name Alpha/Numeric The track file name, in quotes, of the track territory to 
be loaded. 

6 Start Day Su, Mo, Tu, We, 
Th, Fr, Sa 
 

The day of the week on which the simulation will 
start.  (Please note that the track territory must have 
a start day and time that is the same as the entry in 
the Start Day and Start Time fields.  If not a 
CMDERR message will be generated.) 

7 Start Time HH:MM The time of the day the simulation will start.  The 
format is the hours followed by a colon and then the 
minutes. 

 
Example: 
CONTROL,0001,LOAD,10:12:11,"C:\Train3\USA BNSF Bakersfield CA - Oakley CA 
2000.trk",tu,0:00 
 

 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

SIMLOAD Request Train Dispatcher 3 to load a previously 
saved simulation. 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

5 File Name Alpha/Numeric The simulation file name, in quotes, of the simulation 
to be loaded. 

 
Example: 
CONTROL,0001,SIMLOAD,10:12:11,"C:\Train3\USA BNSF Bakersfield CA - Oakley CA 
2000.ssm" 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

START Requests Train Dispatcher 3 to start the simulation. 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

 
Example: 
CONTROL,0013,START,23:12:11 
 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

STOP Requests Train Dispatcher 3 to stop (pause) the 
simulation. 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

Example: 
CONTROL,0015,STOP,12:12:11 
 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

TIME Requests Train Dispatcher 3 to send the current 
simulation time (TIME indication record). 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

 
Example: 
CONTROL,0023,TIME,15:46:09 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type CONTROL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Command 
Type 

ALLDATA Requests Train Dispatcher 3 to send all switch, signal 
and block indication records. 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

 
Example: 
CONTROL,0034,ALLDATA,14:33:19 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type SIGNAL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Signal 
Name 

Alpha/Numeric Each signal, when created by Track Builder 3, can be 
assigned a unique remote monitor name that identifies 
the signal to the external program.  If a remote 
monitor name was not assigned, Train Dispatcher 3 
will recognize a name that uses its internal signal 
number.  The format is SIGNALXXXX, where XXXX is 
the signal number. 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

5 Signal 
Command 

CANCEL 
CLEAR 
FLEET 
FLEETCANCEL 

The signal command being issued.  Commands can 
be issued for canceling a signal, clearing a signal, 
fleeting a cleared signal or canceling a fleeted signal. 

 
Example: 
SIGNAL,0112,SIGNAL0122,11:15:10,CLEAR 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type SWITCH The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Switch 
Name 

Alpha/Numeric Each switch, created by Track Builder 3, can be 
assigned a unique remote monitor name that identifies 
the switch to the external program.  If a remote 
monitor name was not assigned, Train Dispatcher 3 
will recognize a name that uses its internal switch 
number.  The format is SWITCHXXXX, where XXXX 
is the switch number. 

4 Time HH:MM:SS The time the external program issued this command.  
The first two characters are the hours followed by the 
minutes and seconds. 

5 Switch 
Command 

NORMAL 
REVERSE 

The switch position command being issued.  
Commands can be issued for throwing the switch into 
the normal or reverse position. 

 
Example: 
SWITCH,0187,SWITCH0005,08:32:19,NORMAL 
 
 

12.3. Status Indication Records 
Status records are generated when the status of a block, signal or switch changes, when Train Dispatcher 3 
receives a command record that requests information, or when there is an error in a command record. 
 
Status records contain a series of fields separated by commas.  The first field in the record always defines the 
type of record and the second always contains the sequence number.  
 
The sequence number is a 4-digit number.   Each time Train Dispatcher 3 generates a new record it increments 
the sequence number by one.  When the sequence number reaches 10000, it is reset to zero.  
 
There are five types of status indication records.  The following table lists these types: 
 
Type Field Code Description 
Block BLOCK Contains the current block status 
Signal SIGNAL Contains the current signal status 
Switch SWITCH Contains the current switch status 
Command Error CMDERR Contains error information about a bad command received by Train 

Dispatcher 3 in the td3commands.txt 
Time TIME Contains the simulation time when the simulation time is requested by a 

command issued by the external program 
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Each of the following tables describes the fields in each status indication record type and is followed by an 
example: 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type BLOCK The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Block 
Name 

Alpha/Numeric Each block, when created by Track Builder 3, can be 
assigned a unique remote monitor name that 
identifies the block to the external program.  If a 
remote monitor name was not assigned, Train 
Dispatcher 3 generates one.  The generated name 
will be BLOCKXXXX, where XXXX is the block 
number. 

4 Status CLEAREDRIGHT 
CLEAREDLEFT 
OCCUPIEDLEFT 
OCCUPIEDRIGHT
UNOCCUPIED 

The status code of the block.  The status code is 
composed of the block cleared, occupied or 
unoccupied status followed by the traffic direction if 
the status is cleared or occupied. 
 

5 Time DD-HH:MM:SS The simulation day and time of the status.  The first 
two characters indicate the number of days the 
simulator has been running.  This is followed by a 
hyphen and then the hours, minutes and seconds on 
the simulator’s clock. 

6 Train ID Alpha/Numeric This field will only exist if the status of the block is 
OCCUPIEDLEFT or OCCUPIEDRIGHT.  This field 
contains the train identifier of the first train traveling 
in the direction of the traffic. 

6 Free 
Blocks 

Numeric 0 to 2 This field will only exist if the status of the block is 
CLEAREDLEFT or CLEAREDRIGHT).  This field 
contains the number of blocks ahead of this block 
that are also cleared in the same direction.  If the 
number is greater than 2, 2 will be contained in this 
field. 

 
Example: 
BLOCK,0005,BLOCK0020,OCCUPIEDRIGHT,01-13:12:59,Train2 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type SIGNAL The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Signal 
Name 

Alpha/Numeric Each signal, when created by Track Builder 3, can 
be assigned a unique remote monitor name that 
identifies the signal to the external program.  If a 
remote monitor name was not assigned, Train 
Dispatcher 3 generates one.  The generated name 
will be SIGNALXXXX, where XXXX is the signal 
number. 

4 Status CLEAREDRIGHT 
CLEAREDLEFT 
CLEARRIGHTFLEET
CLEARLEFTFLEET 
STOP 
STOPFAILED 
STOPERROR 

The status code of the signal.  For cleared signals, 
the status code will have CLEARED followed by 
the traffic direction and the fleet indication.  For 
stopped signals, the status code will have STOP 
which maybe followed by FAILED or ERROR.  If 
FAILED, the signal has a problem that may require 
a maintainer to fix.  If ERROR, the signal could not 
be cleared (as requested by the last command) 
because of a traffic conflict. 
 

5 Time DD-HH:MM:SS The simulation day and time of the status.  The 
first two characters indicate the number of days 
the simulator has been running.  This is followed a 
hyphen and then the hours, minutes and seconds 
on the simulator’s clock. 

 
Example: 
SIGNAL,0006,SIGNAL0019,CLEAREDRIGHT,02-09:23:17 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type SWITCH The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Switch 
Name 

Alpha/Numeric Each switch, when created by Track Builder 3, can 
be assigned a unique remote monitor name that 
identifies the switch to the external program.  If a 
remote monitor name was not assigned, Train 
Dispatcher 3 generates one.  The generated name 
will be SWITCHXXXX, where XXXX is the switch 
number. 

4 Position NORMAL 
REVERSE 
NORMALFAILED 
REVERSEFAILED 
NORMALERROR 
REVERSEERROR

The position code of the switch.  The position code 
indicates whether the switch is in the normal or 
reverse position.  This may be followed by FAILED or 
ERROR.  If FAILED, the switch has a problem that 
may require a maintainer to fix.  If ERROR, the 
switch position could not be changed (as requested 
by the last command) because of a traffic conflict. 

5 Time DD-HH:MM:SS The simulation day and time of the status.  The first 
two characters indicate the number of days the 
simulator has been running.  This is followed by a 
hyphen and then the hours, minutes and seconds on 
the simulator’s clock. 

6 Status CLEAREDRIGHT 
CLEAREDLEFT 
OCCUPIEDRIGHT
OCCUPIEDLEFT 
UNOCCUPIED 

The status code of the switch.  The status code is 
composed of the switch cleared, occupied or 
unoccupied status followed by the traffic direction if 
the status is cleared or occupied. 

 
Example: 
SWITCH,0056,SWITCH0199,NORMALERROR,01-17:12:54,OCCUPIEDLEFT 
 
 

Field 
Number 

Data 
Name 

Data Format Description 

1 Type CMDERR The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Error 
message 

Alpha/Numeric A text error message, in quotes, that explains the 
problem with the command record. 

4 Command 
Record 

Alpha/Numeric The command record, in quotes, with which this error 
message is associated. 

 
Example: 
CMDERR,0008,"The signal named in the third field of the message could not be found 
on the track layout", "SIGNAL,0011,SIGNAL0412,12:23:17, CLEAR" 
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Field 

Number 
Data 
Name 

Data Format Description 

1 Type TIME The type of record. 
2 Sequence 

Number 
0 thru 9999 The record sequence number. 

3 Time DD-HH:MM:SS The current simulation day and time.  The first two 
characters indicate the number of days the simulator 
has been running.  This is followed by a hyphen and 
then the hours, minutes and seconds on the 
simulator’s clock. 

 
Example: 
TIME,0034,”01-15:11:12 
 
 
 
 

13. TECHNICAL SUPPORT 
Signal Computer Consultants provides free technical support for up to one year after purchase to registered 
Train Dispatcher 3 customers for all Train Dispatcher 3 functions with the exception of the CTC Control Mode 
and External I/O Mode functions.  A separate support contract is available for CTC Control and External I/O 
Mode functions.  Please contact Signal Computer Consultants for more information. 

To obtain technical support contact Signal Computer Consultants via the following means: 

• Telephone 412 655-1884 

• Facsimile 412 655-1893 

• E-mail signal@signalcc.com 

14. WARRANTY 
If Train Dispatcher 3 does not operate correctly on the computer on which you initially installed Train Dispatcher 
3, and, after you contact us about the problem, we are not able to solve it within a 2-week period, our policy is to 
give you a 100% refund on the purchase price of the program.  To obtain this refund we must have the original 
CD Rom returned to us. 

 

 

 

 



 

   
 

Index 
 
active block permits window................................. 32 
active slow order window...................................... 33 
active train list ....................................................... 28 
alert 

"Go to" button................................................ 3, 35 
"Next" button ................................................. 3, 35 
"Prev" button ................................................. 3, 35 
options............................................................... 39 
sounds............................................................... 40 
status line.......................................................... 35 
system description ............................................ 34 

automatic signaling at diamonds: .......................See 
signal:automatic control at diamonds 

block 
clear route ........................................................... 5 
displaying 

length............................................................... 8 
names.............................................................. 8 
signal direction ................................................ 8 
speeds............................................................. 8 

find .................................................................... 57 
length ................................................................ 11 
occupied.............................................................. 5 
permit active........................................................ 5 
permit pending .................................................... 5 
properties - general dialog ................................ 10 
speeds.......................................................22. See 
stack.................................................................... 5 
status line............................................................ 9 
symbol................................................................. 5 
track names ...................................................... 10 

block permit 
activation........................................................... 41 
active............................................................. 5, 32 
CTC Control Mode ............................................ 61 
pending ............................................................... 5 
request authorization dialog.............................. 26 
territory data...................................................... 53 

changing the territory............................................ 16 
clock time................................................................ 3 
comments about territory...................................... 41 
crew expiration activation ..................................... 41 
CTC Control Mode.......................................... 18, 58 
diamond 

find .................................................................... 57 
status line.......................................................... 14 
symbol................................................................. 6 
train frequency .................................................. 25 

entrance/exit 
priorites ............................................................. 52 
symbol................................................................. 6 
territory data...................................................... 52 

entrance/exit commands.... See signal:entrance/exit 
commands 

External I/O Mode ...........................................18, 70 
finding train, block, switch, diamond or signal ......57 
fleeting signals ............................ See signal:fleeting 
function activation .................................................41 
helper 

activation ...........................................................41 
merging with trains ............................................24 

installation ...............................................................1 
log 

CTC Control Mode.............................................59 
External I/O Mode..............................................71 

merge train ...............................See train commands 
modes of operation ...............................................16 
moving around the screen ......................................6 
multiple entries ......................................................47 
opening a saved simulation ..................................16 
options 

alert....................................................................39 
random defect detector performance ................37 
random switch and signal failures .....................38 
random train performance .................................36 

OS points ..............................................................56 
pass red signal commands ......See train commands 
passenger schedule..............................................49 
performance 

data window.......................................................31 
status line ............................................................4 

permission to enter territory ..................................26 
platform 

symbol .................................................................6 
platform train schedule..........................................30 
playback mode......................................................17 
properties 

block ..................................................................10 
switch.................................................................13 
train....................................................................46 

restarting a simulation...........................................15 
reverse train .............................See train commands 
running time ......................................................6, 20 
saving a simulation................................................16 
scrolling the screen .................................................6 
signal 

automatic control at diamonds ..........................22 
control................................................................19 
entrance/exit commands ...................................20 
failure.................................................................38 
find.....................................................................57 
fleeting ...........................................................6, 20 
running time...................................................6, 20 
stack route commands ......................................21 



 

   
 

status .................................................................19 
symbol .................................................................6 

simulation mode ....................................................17 
simulation time ........................................................3 
slow orders 

activation ...........................................................41 
active .................................................................33 
territory data ......................................................54 

sound on/off ............................................................3 
split train ...................................See train commands 
stacking a route.. See signal:stack route commands 
start times 

territory data ......................................................50 
start train ..................................See train commands 
start/stop button ......................................................3 
starting a simulation ..............................................14 
starting the program................................................1 
status display line....................................................4 

alerts ..................................................................35 
block ..............................................................9, 13 

status line 
diamond.............................................................14 
switch.................................................................13 

stop train...................................See train commands 
switch 

control ................................................................18 
failure.............................................................6, 38 
find .....................................................................57 
positions ............................................................18 
properties dialog ................................................13 
reverse speeds ..................................................14 
status line ..........................................................13 
symbol .................................................................6 

technical support ...................................................79 
territory 

arrival permission ..............................................26 
arrival schedule .................................................29 
data....................................................................41 
libraries ..............................................................15 

Test Handler..........................................................62 
time multiplier ..........................................................3 
track file 

loading ......................... See changing the territory 
track names.......................... See block:track names 

find .................................................................... 57 
train 

active train list window ...................................... 28 
entrance ............................................................ 29 
exit..................................................................... 29 
find .................................................................... 57 
icons.................................................................. 44 
length .......................................................... 28, 46 
multiple entries dialog ....................................... 47 
OS window........................................................ 29 
passenger schedule.......................................... 49 
platform schedule.............................................. 30 
properties - general dialog ................................ 46 
random performance......................................... 36 
status line .......................................................... 27 
territory arrival schedule.................................... 29 
territory data...................................................... 44 
work schedule ................................................... 48 

train command 
change crew...................................................... 24 
merge with train................................................. 24 
pass red signal .................................................. 23 
reverse .............................................................. 23 
split train............................................................ 24 
start ................................................................... 23 
stop ................................................................... 23 

train commands .................................................... 22 
train frequency at junctions..........See diamond:train 

frequency 
train graph............................................................. 31 
train speeds ..................................See block:speeds 
train tracking ......................................................... 59 
train types ....................................................... 43, 54 
trains at junctions........See diamond:train frequency 
view 

classic ................................................................. 7 
graphic ................................................................ 7 

warranty ................................................................ 79 
wayside detector 

random performance......................................... 37 
territory data...................................................... 56 

what’s new.............................................................. 1 
work schedule....................................................... 48 
zoom in/out ............................................................. 3 

 


